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Package Contents

Package Contents

D-Link AirPremier™ DWL-3200AP
Managed Wireless Access Point

Power over Ethernet base unit
Power Adapter-DC 48V, 0.4A
Power Cord

Manual and Warranty on CD
Quick Installation Guide
Ethernet Cable

Mounting Plate

Note: Using a power supply with a different voltage than the one included with the
DWL-3200AP will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

Minimum System Requirements

B Computers with Windows®, Macintosh®, or Linux-based operating systems with

an installed Ethernet Adapter

B Internet Explorer version 6.0 or Netscape Navigator™ version 7.0 and above

D-Link Systems, Inc.
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Introduction

At up to fifteen times the speed of previous wireless devices (maximum wireless signal
rate of up to 108Mbps* in Super G mode), you can work faster and more efficiently,
increasing productivity. With the DWL-3200AP, bandwidth-intensive applications like
graphics or multimedia will benefit significantly because large files are able to move
across the network quickly.

The DWL-3200AP is capable of operating in one of 3 different wireless networking
modes; access point, WDS (Wireless Distribution System) with AP, or WDS mode.

Use less wiring, enjoy increased flexibility, save time and money with PoE (Power over
Ethernet). With PoE, the DWL-3200AP shares power and data over the CAT5 cable,
making the setup of your network less expensive and more convenient.

An ideal solution for quickly creating and extending a wireless local area network
(WLAN) in offices or other workplaces, trade shows and special events, the DWL-3200AP
provides data transfers at up to 108Mbps in Super G mode when used with other
D-Link AirPremier products. (The 802.11g standard is backwards compatible with
802.11b devices.)

WPA is offered in two flavors: Enterprise (used for corporations) and Personal (used
for home users).

WPA-Personal and WPA2-Personal is directed at home users who do not have the
server based equipment required for user authentication. The method of authentication
is similar to WEP because you define a “Pre-Shared Key” on the wireless router/AP.
Once the pre-shared key is confirmed and satisfied on both the client and access point,
then access is granted. The encryption method used is referred to as the Temporal Key
Integrity Protocol (TKIP), which offers per-packet dynamic hashing. It also includes an
integrity checking feature which ensures that the packets were not tampered with during
wireless transmission. WPA2-Personal is far superior to WPA-Personal, because the
encryption of data is upgraded with the Advanced Encryption Standard (AES).

*’Maximum wireless signal rate derived from IEEE Standard 802.11g specifications. Actual data throughput will vary. Network
conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead
lower actual data throughout rate.”
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WPA-Enterprise and WPA2-Enterprise is ideal for businesses that have existing
security infrastructures in place. Management and security implementation can now
be centralized on a server participating on the network. Utilizing 802.1x with a RADIUS
(Remote Authentication Dial-in User Service) server, a network adminstrator can define
a list of authorized users who can access the wireless LAN. When attempting to access
a wireless LAN with WPA-Enterprise or WPA2-Enterprise configured, the new client will
be challenged with a username and password. If the new client is authorized by the
administration, and enters the correct username and password, then access is granted.
In a scenario where an employee leaves the company, the network administrator can
remove the employee from the authorized list and not have to worry about the network
being compromised by a former employee. WPA2-Enterprise is far superior to
WPA-Enterprise, because the encryption of data is upgraded with the Advanced
Encryption Standard (AES).

802.1x: Authentication which is a first line of defense against intrusion. In the
authentication process, the Authentication Server verifies the identity of the client
attempting to connect to the network. Unfamiliar clients would be denied access.

EAP (Extensible Authentication Protocol) is available through the Windows® XP
operating system. You will need to use the same type of EAP protocol on all devices in
your network when using the 802.1x feature.

D-Link Systems, Inc. 5
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Features and Benefits

3 Different Operation modes - Capable of operating in one of three different
operation modes to meet your wireless networking requirements: Access Point;
WDS with AP, or WDS.

Easy Installation with PoE (Power over Ethernet).

Faster wireless networking with the 802.11g standard to provide a maximum
wireless signal rate of up to 54Mbps* (maximum wireless signal rate of up to
108Mbps* in Super G mode).

Compatible with the 802.11b standard to provide a wireless data rate of up to
11Mbps - that means you can migrate your system to the 802.11g standard on
your own schedule without sacrificing connectivity.

Better security with WPA - The DWL-3200AP can securely connect wireless
clients on the network using WPA (Wi-Fi Protected Access) providing a much
higher level of security for your data and communications than has previously
been available.

AP Manager Setup Wizard - The new Setup Wizard makes network
configuration quick and simple.

SNMP for Management - The DWL-3200AP is not just fast but it also supports
SNMP v.3 for a better network management. Superior wireless AP manager
software is bundled with the DWL-3200AP for network configuration and
firmware upgrade. Systems administrators can also setup the DWL-3200AP
easily with the Web-based configuration. A D-Link D-View module will be
downloadable for network administration and real-time network traffic monitoring
with D-Link D-View software.

Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing).
Operates in the 2.4GHz frequency range.
Web-based interface for managing and configuring.

*’Maximum wireless signal rate derived from IEEE Standard 802.11a and 802.11g specifications. Actual data throughput will
vary. Network conditions and environmental factors, including volume of network traffic, building materials and construction, and
network overhead lower actual data throughout rate.”

D-Link Systems, Inc. 6



DWL-3200AP User’s Manual Wireless Basics

Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and
compatible high-speed wireless connectivity within your home, business or public
access wireless networks. D-Link wireless products will allow you access to the data you
want, when and where you want it. You will be able to enjoy the freedom that wireless
networking brings.

A Wireless Local Area Network (WLAN) is a computer network that transmits and
receives data with radio signals instead of wires. WLANs are used increasingly in both
home and office environments, and public areas such as airports, coffee shops and
universities. Innovative ways to utilize WLAN technology are helping people to work
and communicate more efficiently. Increased mobility and the absence of cabling and
other fixed infrastructure have proven to be beneficial for many users.

Wireless users can use the same applications they use on a wired network. Wireless
adapter cards used on laptop and desktop systems support the same protocols as
Ethernet adapter cards.

People use WLAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-time
information can significantly improve worker efficiency.

Low Implementation Costs - WLANS are easy to set up, manage, change and relocate.
Networks that frequently change can benefit from WLANs ease of implementation.
WLANSs can operate in locations where installation of wiring may be impractical.

Installation and Network Expansion - Installing a WLAN system can be fast and easy
and can eliminate the need to pull cable through walls and ceilings. Wireless technology
allows the network to go where wires cannot go - even outside the home or office.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices. The DWL-3200AP saves money by providing
multi-functionality, configurable in one of four different modes.

Scalability - WLANs can be configured in a variety of ways to meet the needs of
specific applications and installations. Configurations are easily changed and range
from Peer-to-Peer networks suitable for a small number of users to larger Infrastructure
networks to accommodate hundreds or thousands of users, depending on the number
of wireless devices deployed.

D-Link Systems, Inc. 7
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Standards-Based Technology

The DWL-3200AP Managed Wireless Access Point utilizes the 802.11b and the 802.11g
standards.

The IEEE 802.119g standard is an extension of the 802.11b standard. It increases the
maximum wireless signal rate of up to 54Mbps* (maximum wireless signal rate of up
to 108Mbps* in Super G mode) within the 2.4GHz band, utilizihg OFDM technology.

This means that in most environments, within the specified range of this device, you will
be able to transfer large files quickly or even watch a movie in MPEG format over your
network without noticeable delays. This technology works by transmitting high-speed
digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division Multiplexing)
technology. OFDM works by splitting the radio signal into multiple smaller sub-signals
that are then transmitted simultaneously at different frequencies to the receiver. OFDM
reduces the amount of crosstalk (interference) in signal transmissions.

The D-Link DWL-3200AP will automatically sense the best possible connection speed
to ensure the greatest speed and range possible.

802.11g offers the most advanced network security features available today, including
WPA and WPA2.

*’Maximum wireless signal rate derived from IEEE Standard 802.11g specifications. Actual data throughput will vary. Network
conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead
lower actual data throughout rate.”
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Installation Considerations

The D-Link AirPremier DWL-3200AP lets you access your network, using a wireless
connection, from virtually anywhere within its operating range. Keep in mind, however,
that the number, thickness and location of walls, ceilings, or other objects that the
wireless signals must pass through, may limit the range. Typical ranges vary depending
on the types of materials and background RF (radio frequency) noise in your home or
business. The key to maximizing wireless range is to follow these basic guidelines:

Keep the number of walls and ceilings between the DWL-3200AP and other network
devices to a minimum - each wall or ceiling can reduce your DWL-3200AP’s range
from 3-90 feet (1-30 meters.) Position your devices so that the number of walls or
ceilings is minimized.

Be aware of the direct line between network devices. A wall that is 1.5 feet thick
(.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter) thick. At a
2-degree angle it looks over 42 feet (14 meters) thick! Position devices so that the
signal will travel straight through a wall or ceiling (instead of at an angle) for better
reception.

Building materials can impede the wireless signal - a solid metal door or aluminum
studs may have a negative effect on range. Try to position wireless devices and
computers with wireless adapters so that the signal passes through drywall or open
doorways and not other materials.

Keep your product away (at least 3-6 feet or 1-2 meters) from electrical devices or
appliances that generate RF noise.

D-Link Systems, Inc. 9
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Three Operational Modes

Three Operational Modes

Operation Mode
(Only supports 1 mode at a time)

Access Point (AP)
WDS with AP

WDS

Function

Create a Wireless LAN

Wirelessly Connect Multi Networks
While still Functioning as a
Wireless AP

Wirelessly Connect Multi Networks

D-Link Systems, Inc.
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Getting Started

Internet ;
\’ S\~ Cable/DSL Modem

Wired Router

Mahaged Wi‘r'eylyess Access Point

DELINK

- o

Managed Wifeleéé Access Point

;‘
p . ,
Computer 2 with Computer 3 with

Wireless G Adapter ~ Wireless 108G Adapter

You will need broadband Internet access.

Consult with your Cable or DSL provider for proper installation of the modem.

Connect the Cable or DSL modem to a Router.
(See the printed Quick Installation Guide included with your router.)

Connect the Ethernet Broadband Router to the PoE base unit.
(See the printed Quick Installation Guide included with the DWL-3200AP)

Connect the DWL-3200AP to the PoE base unit.
(See the printed Quick Installation Guide included with the DWL-3200AP)

If you are connecting a desktop computer to your network, install the D-Link
WDA-2320 wireless PCI adapter into an available PCI slot on your desktop
computer.

(See the printed Quick Installation Guide included with the network adapter.)

Install the drivers for the D-Link WNA-2330 wireless Cardbus adapter into a
laptop computer.
(See the printed Quick Installation Guide included with the WNA-2330.)

D-Link Systems, Inc. 11
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Connecting PoE (Power over Ethernet)

Step 3

P+DATA

DLink

DATA jefe  OUT  step1
IN = =

I Step 2
i B

Router or Switch Computer
(Straight Through Cable) (Crossover Cable)

Step 1 Connect one end of an Ethernet cable (included with your package) to
the LAN port on the DWL-3200AP and the other end of the Ethernet
cable to the port labeled P+DATA OUT on the PoE base unit.

Step2 Connect another Ethernet cable from the DATA IN port on the PoE
base unit to your router/switch, using a straight through cable, or to
a PC, using a crossover cable.

Step 3 Attach the power adapter to the connector labeled POWER IN on
the PoE base unit. Attach the power cord to the power adapter and
into an electrical outlet.

D-Link Systems, Inc. 12
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Using the Configuration Menu

To configure the DWL-3200AP, use a computer which is connected to the DWL-3200AP
with an Ethernet cable (see the Network Layout diagram).

First, disable the Access the Internet using a proxy server function. To disable this
function, go to Control Panel > Internet Options > Connections > LAN Settings
and uncheck the enable box.

Start your web browser program (Internet Explorer, Netscape Navigator™) .

Type the IP address and http port of the DWL-3200AP in the address field
(http://192.168.0.50) and press Enter. Make sure that the IP addresses of the
DWL-3200AP and your computer are in the same subnet.

A Wicrosoft Internet Explorer

File Edit Miew Favorites Tools  Help

eBack > Iﬂ ﬂ 'y / | Search :\?’

Address | @] http /192, 168.0,50/

After the connection is established, you will see the user identification window as

shown.
Note: If you have changed the default IP address assigned to the DWL-3200AF, make sure to

enter the correct IP address.

u Type admin in the User Name field
u Leave the Password field blank
o Click OK

Connect to 192.168.0.50

2

"1'| 3.::'\.

DWL-3200AP

Lser name: |ﬁ“| vl

Password: | |

[ Jremember my password

[ Ok l[ Cancel ]

Note: If you have changed the password, make sure to enter the correct password.

D-Link Systems, Inc. 13
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Home > Wizard

The Home>Wizard screen will appear. Please refer to the Quick Installation Guide for
more information regarding the Setup Wizard.

D-Link

Home Advanced i‘ools Status Help

Setup Wizard

— - - i
Building Metworks for People -_A I" p" em|8r
The DWL-3200AP is a Wireless Access Point. The setup wizard will guide you

2.4GHz Wireless Access Point with PoE
DWLﬂ-SiUQﬂ.P
through the configuration of the DWL-3200AP. The DWL-3200AP’s easy setup will

' Wiraless allow you te have wireless access within minutes. Please follow the setup wizard
step by step to configure the DWL-3200AP.

[i(d

Run \Wizard 1

Help

These buttons appear on most of the configuration screens in this section. Please

click on the appropriate button at the bottom of each screen after you have made a
configuration change.

Clicking Apply will save changes made to the page
Apply

2-3 Clicking Cancel will clear changes made to the page
Cancel

o Clicking Help will bring up helpful information regarding the page
Help

@ Clicking Restart will restart the router. (Necessary for some changes.)
Restart

D-Link Systems, Inc. 14
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Home > Wireless > AP mode
D-Link

Building Networks for People

Wireless Band:

Mode:

SSID:

SSID Broadcast:

Channel:

A Premier”
2.4GHz Wireless Access Pointwith PoE

([T N Advanced  Tools Status Help
Wireless Band
Mode | Access Point [v]
SSID ‘dlink
SSID Broadcast _Enab.le |:]|
Channel 2452 GHz Auto Channel Scan
Authentication f.Open System |Vf
Key Settings G abial A -

Encryption @ Disable  (Enable

Key Type Key Size

Valid Key

First Key TIIILIIL

Second Key

Third Key

Fourth Key
Radio ‘onlv|
Super G Mode | Disable |\:]

9 9O
Apply Cancel Help
IEEE 802.11¢g

Access Point is selected from the pull-down menu.

Service Set Identifier (SSID) is the name designated for a specific
wireless local area network (WLAN). The SSID’s factory default
setting is dlink. The SSID can be easily changed to connect to an
existing wireless network or to establish a new wireless network. The
SSID can be up to 32 characters and is case-sensitive.

Enable or Disable SSID broadcast. Enabling this feature broadcasts
the SSID across the network.

Auto Channel Scan is set by default. All devices on the network
must share the same channel. To change the channel, uncheck Auto
Channel Scan. (Note: The wireless adapters will automatically scan
and match the wireless setting.)

D-Link Systems, Inc.
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Using the Configuration Menu

Home > Wireless > AP mode (continued)

Auto Channel
Scan:

Authentication:

Radio:

Super G Mode:

Select Enable or Disable. (Enable this feature to auto-select the
channel for best wireless performance.)

Open System

Shared Key

Open System/Shared Key
WPA-Enterprise
WPA-Personal
WPA2-Enterprise
WPA2-Personal
WPA-Auto-Enterprise
WPA-Auto-Personal

Select Open System to communicate the key across the
network.

Select Shared Key to limit communication to only those devices
that share the same WEP settings.

Select Open System/Shared Key to allow either form of data
encryption.

Select WPA-Enterprise, WPA2-Enterprise, WPA-Auto-Enterprise
to secure your network with the inclusion of a RADIUS server.

Select WPA-Personal, WPA2-Personal, WPA-Auto-Personal to
secure your network using a password and dynamic key changes.
(No RADIUS server required).

Select On or Off.

Super G is a group of performance enhancement features that
increase end user application throughput in an 802.11g network.
Super G is backwards compatible to standard 802.11g devices.
For top performance, all wirelss devices on the network should be
Super G capable. Select either Disabled, Super G without Turbo,
or Super G with Dynamic Turbo.

Disabled: | Standard 802.11g support, no enhanced capabilities.

Super G | Capable of Packet Bursting, FastFrames, Compression,
without | and no Turbo mode.
Turbo:

Super | Capable of Packet Bursting, FastFrames, Compression,

G with | and Dynamic Turbo. This setting is backwards compatible

Dynamic | \yith non-Turbo (legacy) devices. Dynamic Turbo mode is

Turbo: | o1y enabled when all devices on the wireless network are
configured with Super G with Dynamic Turbo enabled.

D-Link Systems, Inc.

16



DWL-3200AP User’s Manual Using the Configuration Menu

Home > Wireless > AP mode > WEP Encryption

Encryption: | Select Disabled or Enabled. (Disabled is selected here).

Key Type*: | Select HEX or ASCII.

Key Size: | Select 64-, 128-, 152-Dits.
Valid Key: | Select the 1st through the 4th key to be the active key.

First through | Input up to four keys for encryption. You will select one of these
Fourth keys: | keys in the valid key field.

*Hexadecimal digits consist of the numbers 0-9 and the letters A-F

*ASCII (American Standard Code for Information Interchange) is a code for
representing English letters as numbers from 0-127

D-Link Systems, Inc. 17
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Using the Configuration Menu

Home > Wireless > AP mode > WPA-Enterprise, WPA2-Enterprise,

& WPA-Auto-Enterprise

Building Metworks for People

DWL-“DOAP

Wizard

=

Wireless

Cipher Type:

Group Key Update
Interval:

RADIUS Server:

RADIUS Port:

RADIUS Secret:
Accounting Mode:

Accounting Server:

Accounting Port:

- - -
— Th:
A/r Premier”
2.4GHz Wireless Access Point with PoE
(1, -3 Advanced  Tools Status Help
Wireless Band ]
Mode Access Point.i-_\'_Jf
SSID (diink
SSID Broadcast 'Enab_le |_V_
Channel 2452 GHz Auto Channel Scan
Authentication WPA-Enterprise IV[
RADIUS Server Settings

Cipher Type |AUTO "’_l Group Key Update Interval |1800

RADIUS Semver |

RADIUS Port  [1812

RADIUS Secret |

;ZZZUHHHQ . D.i.sable iv_i

Accounting

Server

Accounting Port ._ 313
Radio [only]
Super G Mode [ Disable iVJ

9 OO
Apply Cancel Help

When you select WPA-Enterprise, you must select AUTO, AES, or
TKIP from the pull down menu.

Select the interval during which the group key will be valid.
1800 is the recommended value. A lower interval may reduce data
transfer rate.

Enter the IP address of the RADIUS server.

Enter the RADIUS port.

Enter the the RADIUS secret.

Select if you want to use a different server for accounting.
Enter the IP address of the Accounting server.

Enter the Accounting port (1813 is default).

D-Link Systems, Inc.
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Home > Wireless > AP mode > WPA-Personal, WPA2-Personal,
& WPA-Auto-Personal

D-Link

o Neorks s e AirPremier”
2.4GHz Wireless Access Pointwith PoE

Home Advanced  Tools Status Help

Wireless Band

Mode | Access Point v
SSID (dilink
Wisles 3SID Broadcast :Enab.le |:1|
Channel : 2452 GHz Auto Channel Scan
i Authentication [WPA-Personal [l
PassPhrase Settingsﬂ L e -
Cipher Type AUTO[:’] Group Key Update Interval :'Iﬁﬁﬂ
PassPhrase |
Radio [on|v]
Super G Mode i:)_-@ab-l_é Tl

2 90

Apply Cancel Help

Cipher Type: | When you select WPA-Personal, please select AUTO, AES, or TKIP
from the pull down menu.

Group Key Update | Select the interval during which the group key wll be valid. The default
Interval: | value of 1800 is recommended.

PassPhrase: | When you select WPA-Personal, please enter a PassPhrase in the
corresponding field.

D-Link Systems, Inc. 19
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Home > Wireless > WDS with AP mode
D-Link

Bt eorsfor et Air Premier”
2.4GHz Wireless Access Point with PoE
DWL-3200AP
LT - Advanced  Tools Status Help
Wireless Band
Mode |wDs with AP [ ]
ssiD [tink
SSID Broadcast | Enable \V\\
Channel [5 [v]zamaame Auto Channel Scan
WDS with AP
Remote AP MAC Address
1 2
3[ 4]
5] 6
7[ 8
WDS Site Survey
Type CH RSSI BSSID Security SSID
Authentication Open System Iv
Key Settings
Encryption @Disable  OEnable
Key Type Key Size
Valid Key
First Key
Second Key
Third Key
Fourth Key
Radio [on[¥]
Super G Mode 'Di§ab.le :j{‘
("
gy Cﬁe‘ Elr.v

In WDS with AP mode, the DWL-3200AP wirelessly connects multiple networks, while
still functioning as a wireless AP.

Wireless Band: | IEEE 802.11g
Mode: | WDS with AP mode is selected from the pull-down menu.

SSID: | Service Set Identifier (SSID) is the name designated for a specific
wireless local area network (WLAN). The SSID’s factory default
setting is dlink. The SSID can be easily changed to connect to an
existing wireless network or to establish a new wireless network.

SSID Broadcast: | Enable or Disable SSID broadcast. Enabling this feature broadcasts
the SSID across the network.

Channel: | 6 is the default channel. All devices on the network must share the
same channel. (Note: The wireless adapters will automatically scan
and match the wireless setting.)

D-Link Systems, Inc. 20
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Using the Configuration Menu

Home > Wireless > WDS with AP mode (continued)

Auto Channel | Select Enable or Disable. (Enable this feature to auto-select the

Scan:

channel for best wireless performance.)

Remote AP MAC | Enter the MAC addresses of the APs in your network that will serve

Address:
WDS Site Survey:

Authentication:

Radio:

Super G Mode:

as bridges to wirelessly connect mulitple networks.

Click on the Scan button to search for available wireless networks.
Click on the network you want to connect to.

Open System

Shared Key

Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

Select Open System to communicate the key across the network.

Select Shared Key to limit communication to only those devices that
share the same WEP settings.

Select Open System/Shared Key to allow either form of data
encryption.

Select WPA-Personal, WPA2-Personal, or WPA-Auto-Personal to
secure your network using a password and dynamic key changes.
(No RADIUS Server required).

Select On or Off.

Super G is a group of performance enhancement features that
increase end user application throughput in an 802.11g network.
Super G is backwards compatible to standard 802.11g devices.
For top performance, all wirelss devices on the network should be
Super G capable. Select either Disabled, Super G without Turbo,
or Super G with Dynamic Turbo.

Disabled: | Standard 802.11g support, no enhanced capabilities.

Super G
without | Capable of Packet Bursting, FastFrames, Compression,
Turbo: | and no Turbo mode.

Super | Capable of Packet Bursting, FastFrames, Compression,

G with | and Dynamic Turbo. This setting is backwards compatible

Dynamic | with non-Turbo (legacy) devices. Dynamic Turbo mode is

Turbo: | only enabled when all devices on the wireless network are
configured with Super G with Dynamic Turbo enabled.

D-Link Systems, Inc.
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Home > Wireless > WDS with AP mode > WEP Encryption

Encryption: | Select Disabled or Enabled. (Disabled is selected here).

Key Type*: | Select HEX or ASCII.

Key Size: | Select 64-, 128-, 152-bits.
Valid Key: | Select the 1st through the 4th key to be the active key.

First through | Input up to four keys for encryption. You will select one of these
Fourth keys: | keys in the valid key field.

Home > Wireless > WDS with AP mode > WPA-Personal,
WPA2-Personal, & WPA-Auto-Personal

Air Premier”

2.4GHz Wireless Access Point with PoE

;] N Advanced  Tools Status Help

Wireless Band
:
o Mode WDS with AP [v]
ssip diink
Wireless SSID Broadeast Enable [
Channel 6 |v|zas76r Auta Channel Scan
LAN WDS with AP
Remote AP MAC Address

1

@ @ e

o
7
WDS Site Survey

Type CH RSSI BSSID Security ssiD

Authentication WPA-Persona e
PassPhrase Settings
Gipher Type  |AUTO [v] Group Key Update Interval 1800

PassPhrase

Radio on[v]
Super G Mode | Disable [ie]

2 0O

Apply Cancel Help

Cipher Type: | When you select WPA-Personal, AES is used here.

Group Key Update | Select the interval during which the group key wll be valid. The
Interval: | default value of 1800 is recommended, a lower interval may reduce
the data transfer rate.

PassPhrase: | When you select WPA-Personal, please enter a PassPhrase in the
corresponding field.

D-Link Systems, Inc. 22
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Using the Configuration Menu

Home > Wireless > WDS mode

D-Link

Building Netwarks for People ~Al.f" pr‘emier‘w
2.4GHz Wireless Access Point with POE
DWL-3200AP
1 N Advanced Tools Status Help
Wireless Band ~EE802
Mode |wos [x]
SSID diink
| Wireless SSID Broadcast | Enable !‘*\
Channel |6 7!__"}2437 GHz Auto Channel Scan
N WDS
Remote AP MAC Address
1 2
3 4
5 6
7[ 8
WDS Site Sunvey
Type CH RSSI BSSID Security SSID
Authentication :Opan System IVI
Key Settings
Encryption @®Disable  (OFnable
Key Type Key Size
Valid Key
First Key
Second Key
Third Key
Fourth Key
Radio [onl¥]
Super G Mode Disable \’:[
% 90
Apply Cﬁet Help

In WDS mode, the DWL-3200AP wirelessly connects multiple networks, without
functioning as a wireless AP.

Wireless Band:

Mode:

SSID:

SSID Broadcast:

Channel:

|IEEE 802.11g
WDS is selected from the pull-down menu.

Service Set Identifier (SSID) is the name designated for a specific
wireless local area network (WLAN). The SSID’s factory default
setting is default. The SSID can be easily changed to connect to an
existing wireless network or to establish a new wireless network.

Enable or Disable SSID broadcast. Enabling this feature broadcasts
the SSID across the network.

6 is the default channel. All devices on the network must share the
same channel.
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Auto Channel
Scan:

Remote AP MAC
Address:

WDS Site Survey:

Authentication:

Radio:

Super G Mode:

Select Enable or Disable. (Enable this feature to auto-select the
channel for best wireless performance.)

Enter the MAC addresses of the APs in your network that will serve
as bridges to wirelessly connect mulitple networks.

Click on the Scan button to search for available wireless networks.
Click on the network you want to connect to.

Open System

Shared Key

Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

Select Open System to communicate the key across the net-
work.

Select Shared Key to limit communication to only those devices
that share the same WEP settings.

Select Open System/Shared Key to allow either form of data
encryption.

Select WPA-Personal, WPA2-Personal, or WPA-Auto-Personal to
secure your network using a password and dynamic key changes.
(No RADIUS Server required).

Select On or Off.

Super G is a group of performance enhancement features that
increase end user application throughput in an 802.11g network.
Super G is backwards compatible to standard 802.11g devices.
For top performance, all wirelss devices on the network should be
Super G capable. Select either Disabled, Super G without Turbo,
or Super G with Dynamic Turbo.

Disabled: | Standard 802.11g support, no enhanced capabilities.

Super G | Capable of Packet Bursting, FastFrames, Compression,

without | and no Turbo mode.
Turbo:

Super | Capable of Packet Bursting, FastFrames, Compression,

G with | and Dynamic Turbo. This setting is backwards compatible

Dynamic | with non-Turbo (legacy) devices. Dynamic Turbo mode is

Turbo: | only enabled when all devices on the wireless network are
configured with Super G with Dynamic Turbo enabled.
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Home > Wireless > WDS mode > WEP

Encryption:
Key Type*:
Key Size:
Valid Key:

First through
Fourth keys:

Select Disabled or Enabled. (Disabled is selected here).

Select HEX or ASCII.

Select 64-, 128-, 152-bits.
Select the 1st through the 4th key to be the active key.

Input up to four keys for encryption. You will select one of these
keys in the valid key field.

Home > Wireless > WDS mode > WPA-Personal, WPA2-Personal,
& WPA-Auto-Personal

Cipher Type:

Group Key Update
Interval:

PassPhrase:

— - - e
A/r Premier
2.4GHz Wireless Access Point with PoE
DWL-3200AP
LT N Advanced  Tools Status. Help
Wireless Band
Mode WDS w
SSID diink
Wireless SSID Broadcast Enable [v]
Channel 6 [v|24376Hz | | Auto Channel Scan
M AN WDS
Remote AP MAC Address
1 2
3[ 4
5 6
7 8
WDS Site Survey
Type CH RSSI BSSID Security SSID
O |aPBSS | 1 26% 00:11:95bc:011d OFF admin
O |APBSS | 11 84% 00:13:46:fe:0d:0b OFF dlink
Authentication Open System >
Key Settings
Encryption @Disable  OEnable
Key Type Key Size
Valid Key
First Key
Second Key
Third Key
Fourth Key
Radio On ||
Super G Made Disable ~]
etk

When you select WPA-Personal, AES is used here.

Select the interval during which the group key wll be valid. The
default value of 1800 is recommended, a lower interval may reduce
the data transfer rate.

When you select WPA-Personal, please enter a PassPhrase in
the corresponding field.
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Home > Wireless Modes
AP Mode Authentication Available
Access Point Open System
Shared Key

Open System/Shared Key
WPA-Enterprise
WPA-Personal
WPA2-Enterprise
WPA2-Personal
WPA-Auto-Enterprise
WPA-Auto-Personal

WDS with AP Open System
Shared Key
Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

WDS Open System
Shared Key
Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

D-Link Systems, Inc. 26



DWL-3200AP User’s Manual Using the Configuration Menu

Home > LAN
D-Link

Building Metworks for People _A ,P p P e I-rl1lerl‘“V
2.4GHz Wireless Access Point with PoE

Home Advanced Tools Status Help
Get IP From | Static (Manual)  ~]
IP Addrass 192.168.0.50
T Subnet Mask ]255.255.255.0
Y Wireless
Default Gateway 0.0.00

LAN 9 9O

Apply Cancel Help

LAN is short for Local Area Network. This is considered your internal network. These
are the IP settings of the LAN interface for the DWL-3200AP. These settings may be
referred to as private settings. You may change the LAN IP address if needed. The LAN
IP address is private to your internal network and cannot be seen on the Internet.

Get IP From: | Static (Manual) is chosen here. Choose this option if you do not have
a DHCP server in your network, or if you wish to assign a static IP
address to the DWL-3200AP.When DHCP is selected the other fields
here will be greyed out.

IP Address: | The default IP address is 192.168.0.50. Assign a static IP address
that is within the IP address range of your network.

Subnet Mask: | Enter the subnet mask. All devices in the network must share the
same subnet mask.

Default Gateway: | Enter the IP address of the gateway in your network. If there isn’t

a gateway in your network, please enter an IP address within the
range of your network.
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Advanced > Performance

D-Link

Performance

! Filter

HCP Server

Multi-SSID

JEREL

Rogue AP

Wireless Band:

Data Rate:*

Beacon Interval:

Fragment Length:

Building Metworks for People

A Premier”

2.4GHz Wireless Access Point with PoE

BT Advanced EPTE

Status Help

Wireless Band —EES(
(Ao ]

Data Rate

Beacon Interval (20 - 1000) 100

DTIM (1 - 255) 1

Fragment Length (256 - 2346) [2346

RTS Length (256 - 2346) 2346

Transmit Power | full - I‘_’I
WM Disable [v]
Preamble Shor’[ and-l._ong.[ﬂ
Wireless B/G Mode [Mixed |vj
Antenna Diversity j.Di\.rersityl ) |ﬂv‘[

9 9O

Apply Cancel Help

|EEE 802.11g

The Data Rates are Auto, 1Mbps, 2Mbps, 5.5Mbps, 6Mbps, 9Mbps,
11Mbps, 12Mbps, 18Mbps, 24Mbps, 36Mbps, 48Mbps, 54Mbps.

Beacons are packets sent by an access point to synchronize a
network. Specify a beacon interval value. The default (100) is
recommended.

(Delivery Traffic Indication Message) - Select a setting between 1and
255. 1is the default setting. DTIM is a countdown informing clients of
the next window for listening to broadcast and multicast messages.

The fragmentation threshold, which is specified in bytes, determines
whether packets will be fragmented. Packets exceeding the 2346
byte setting will be fragmented before transmission. 2346 is the
default setting

*’Maximum wireless signal rate based on |IEEE Standard 802.11a and 802.11g specifications. Actual data throughput will vary.
Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network
overhead lower actual data throughout rate”
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RTS Length:

Transmit Power:

WMM:

Praemble:

Wireless B/G Mode:

Antenna Diversity:

This value should remain at its default setting of 2346. If you
encounter inconsistent data flow, only minor modifications to the
value range between 256 and 2346 are recommended

Choose full, half (-3dB), quarter (-6dB), eighth (-9dB), minimum
power.

Select Enable or Disable, Disable is selected by default. WMM
stands for Wi-Fi Multimedia, by enabling this feature it will improve
the user experience for audio and video applications over a Wi-Fi
network.

Select the default value Short and Long, or Long Only.

This function allows you to configure the wireless network with IEEE
802.11g only, IEEE 802.11b only, or IEEE 802.11g with backward
interoperability with IEEE 802.11b.

The DWL-3200AP supports 2.4GHz radio with two antennas. Radio
is connected to each antenna and supports auto diversity mode by
default. This means that the access point will auto switch to the
antenna with better RSSI value.

Diversity: The DWL-3200AP will auto switch to the antenna with
better RSSI value.

Left Antenna: The AP will not switch antenna and the radio will
use the left antenna (when facing the AP) to transmit and receive
packets.

Right Antenna: AP won’t switch antenna and the radio will use
the right antenna (when facing the AP) to transmit and receive
packets.
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Advanced > Filters > Wireless Access Settings

D-Link

Building Networks for People

A/ Premier”

2.4GHz Wireless Access Point with PoE
DWL-3200AP
[ Home BT CLER Tools Status Help

Wireless Access Settings / WLAN |

T YWyireless Band IEEEB02.11g
erformance e ——
Access Control | Disahle v

.
Filter Mac Address | H Save | a Q o
Ap_plv Cancel Help

[MAC Address |Delete  [MAC Address . fbélété
DHCP Server = :

MMulti-SSID

IEE

Rogue AP

Wireless Band: | |IEEE 802.11g

Access Control: | Select Disabled to disable the filters function.

Select Accept to accept only those devices with MAC addresses
in the Access Control List.

Select Reject to reject the devices with MAC addresses in the
Access Control List.

MAC Address: | Enter the MAC addresses that you wish to include in your filters
list, and click Save.

MAC Address List: | When you enter a MAC address, it appears in this list. Highlight a
MAC address and click Delete to remove it from the list.
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Advanced > Filters > WLAN Partition

D-Link

- - - oa
Baling eovorksfor Popl A Premier
2.4GHz Wireless Access Point with PoE
[ Home BN TLZL IR Tools Status Help
WLAN Partition / Wireless Access Settings
- Wireless Band [EEEBDZ211g
Internal Station Connection Enahle «
Ethernet to WLAN Access | Enable_V|
» OO0
|
! Rogue AP
Wireless Band: | IEEE 802.11g

Internal Station
Connection:

Ethernet to WLAN
Access:

Enabling this feature allows wireless clients to communicate with
each other. If this is disabled, wireless stations of the selected band
are not allowed to exchange data through the access point.

Enabling this feature allows Ethernet devices to communicate with
wireless clients. If this is disabled, all data from the Ethernet to
associated wireless devices is blocked. Wireless devices can still
send data to the Ethernet.
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Advanced > DHCP Server > Dynamic Pool Settings
D-Link

Building Metworks for People :A ’r pPEI I llerw
2.4GHz Wireless Access Pointwith PoE

BTN  Advanced BRI Status Help
Dynamic Pool Settings / Static Pool & C t 1P M y List
DHCP Server Control

Performance Function Enable/Disahle Disahle

Dynamic Pool Settings

IP Azzigned From
The Range of Pool (1-255)

|
|
DHCP Server SubMask | |
Gateway | 000 |
. fea |
DNS [(oos |
Damain Narne |—‘
Lease Time (50 - 31536000 sec) ]
Status

9 90

Apply Cancel Help

DHCP Server | Dynamic Host Configuration Protocol assigns dynamic IP
Control: | addresses to devices on the network. This protocol simplifies

network management and allows new wireless devices to receive

IP addresses automatically without the need to manually assign

new |IP addresses.

Select Enable to allow the DWL-3200AP to function as a DHCP

server.

IP Assigned From: | Input the first IP address available for assignment in your network.

The Range of Pool | Enter the number of IP addresses available for assignment.
(1-255):
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Advanced > DHCP Server > Dynamic Pool Settings (continued)

SubMask:

Gateway:

Wins:

DNS:

Domain Name:

Lease Time

(60-31536000
sec.):

Status:

All devices in the network must have the same subnet mask to
communicate. Enter the submask for the network here.

Enter the IP address of the gateway on the network.

Windows Internet Naming Service is a system that determines the
IP address of a network computer that has a dynamically assigned
IP address.

Enter the IP address of the DNS server. The DNS (Domain Name
Server) translates domain names such as www.dlink.com into IP
addresses.

Enter the domain name of the DWL-3200AP, if applicable. (An
example of a domain name is: www.dlink.com.)

The Lease Time is the period of time before the DHCP server will
assign new |IP addresses.

Turn the Dynamic Pool Settings ON or OFF here.
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Advanced > DHCP Server > Static Pool Settings
D-Link

Building Metworks for People

Performance

DHCP Server

Mauniesin
* Multi-SSID

LR

! Rogue AP

DHCP Server
Control:

Assigned IP:

Assigned MAC
Address:

SubMask:

Gateway:

Air Premier”
2.4GHz Wireless Access Point with PoE
[ Home BV L ER Tools Status Help

Static Pool Settings / Current IP Mapping List / Dynamic Pool Settings

DHCP Server Control

Function Enable/Disable |_D-i@

Static Pool Settings

Assigned IP | |

Assigned MAC Address | |

SubMask | |

Gateway |.;._;-J |

Wins | |

DHS | |

Damain Name | |

Status
9 9O
Apply Cancel Help

Assigned Static Pool

MAC Address IP address State Edit Delete

Dynamic Host Configuration Protocol assigns IP addresses to
wireless devices on the network. This protocol simplifies network
management and allows new wireless devices to receive IP
addresses automatically without the need to manually assign IP
addresses.

Select Enable to allow the DWL-3200AP to function as a DHCP
server.

Use the Static Pool Settings to assign the same IP address to a
device at every restart. The IP addresses assigned in the Static Pool
listmust NOT be in the same IP range as the Dynamic Pool. After you
have assigned a static IP address to a device via its MAC address,
click Apply; the device will appear in the Assigned Static Pool at
the bottom of the screen. Edit or delete the device in this list.

Enter the MAC address of the device here.

Enter the subnet mask here.

Enter the IP address of the gateway on the network.
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Wins: | Windows Internet Naming Service is a system that determines
the IP address of a network computer with a dynamically assigned

IP address, if applicable.

DNS: |Enter the IP address of the Domain Name Server, if applicable.
The DNS translates domain names such as www.dlink.com into IP

addresses.

Domain Name: | Enter the domain name of the DWL-3200AP, if applicable.

Status: | This option turns the Static Pool settings ON or OFF.

Advanced > DHCP Server > Current IP Mapping List
D-Link

AirPremier”
2.4GHz Wireless Access Point with PoE

BT Advanced

Current IP Mapping List / Dynarnic Pool Settings /

Building Networks: for People

ools Help

Status

P ——

Filter

Current DHCP Dynamic Pools
Binding MAC Address

Current DHCP Static Pools

Assigned IP address Lease time

Binding MAC Address Assigned IP address

DHCP Server

Maaowi.een
* Multi-SSID

d

Rogue AP

This screen displays information about the current DHCP dynamic and static IP
address pools. This information is available when you enable the DHCP function of the
DWL-3200AP and assign dynamic and static IP address pools.

Current DHCP | These are IP address pools to which the DHCP server function has
Dynamic Pools: | assigned dynamic IP addresses.
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Advanced > DHCP Server > Current IP Mapping List

(continued)
Binding MAC
address:

Assigned IP address:

Lease Time:

Current DHCP Static
Pools:

Binding MAC
address:

Assigned IP address:

The MAC address of a device on the network that is within the DHCP
dynamic IP address pool.

The current corresponding DHCP-assigned dynamic IP address of
the device.

The length of time that the dynamic IP address will be valid.

These are IP address pools to which the DHCP server function has
assigned static IP addresses.

The MAC address of a device on the network that is within the DHCP
static IP address pool.

The current corresponding DHCP-assigned static IP address of the
device.
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Advanced > Multi-SSID

-
D-Link A ; L
Building Metworks for People P Ir' r‘emler‘
2.4GHz Wireless Access Pointwith PoE
DWL-3200AP
[ Home QLT BR Tools Status Help
Enable Multi-SSID Enable VLAN State
Performance
Band 2
i T
Index [MatissD7 [+]
SsID |mssid?
Security WPA2-Personal | (el
BHCP Server :
VLAN D [4004
PassPhrase Settings
| Multi-$SID Cipher Type | AUTO ]‘V] Group Key Update Interval |1800
PassPhrase password
Rogue AP
Mulit-SSID
Index SSID Band Encryption Vll'DAN Del
Primary dlink 11g OFF 4
| Multi-SSID7 mssid? 11g | WPA2-Persona I [ 4004 [
9 0O
Apply Cancel Help

If you want to configure the Guest and Internal networks on Virtual LAN (VLANS), the
switch and DHCP server you are using must suppport VLANs. As a prerequisite step,
configure a port on the switch for handling VLAN tagged packets as described in the
IEEE802.1Q standard.

Enable Multi-SSID:
Enable VLAN Status:
Band:

Index:

SSID:

Security:

Check to use Multi-SSID.
Check to use a VLAN.
IEEE802.119 is selected.

You can select up to 7 multi-SSIDs. The default multi-SSIDs is the
primary, which puts the total to 8 multi-SSIDs.

Service Set Identifier (SSID) is the name designated for a specific
wireless local area network (WLAN). The SSID’s factory default
setting is default. The SSID can be easily changed to connect to an
existing wireless network or to establish a new wireless network.

The Multi-SSIDs security can be WPA/WPA2-Enterprise or
WPA-Auto-Enterprise only when the Primary SSID’s security is at the
same security level. Also, they must connect to the same RADIUS
server.
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Advanced > Multi-SSID (continued)

VLAN ID: | If you configure enable Guest access and configure Internal and
Guest networks on VLANS, this field will be enabled.

Provide a number between 1 and 4094 for the Internal VLAN.
This will cause the access point to send DHCP requests with the
VLAN tag. The switch and the DHCP server must support VLAN
IEEE802.1Q frames. The access point must be able to reach the
DHCP server.

Check with the Administrator regarding the VLAN and DHCP
configurations.

Key Type: | Select HEX or ASCII.
Key Size: | Select 64-bit, 128-bit, or 152-bit.

Key: | Select the 1st key all the way through the 4th key, to be set as the
active key. Enter key here.

When Primary SSID is set to any of | Multi-SSID can use any of these

the following security levels: security levels:

None None

Open System (WEP) Open System (WEP)
Shared Key (WEP) Shared Key (WEP)
WPA-Personal WPA-Personal
WPA2-Personal WPA2-Personal
WPA-Auto-Personal WPA-Auto-Personal
WPA-Enterprise None
WPA2-Enterprise Open System (WEP)
WPA-Auto-Enterprise Shared Key (WEP)

WPA-Personal
WPA2-Personal
WPA-Auto-Personal
WPA-Enterprise
WPA2-Enterprise
WPA-Auto-Enterprise

Note: If WPA or WPA2 is being used, it will occupy the key space 2 and 3, which will
leave key 1 and 4 for other SSIDs to use for WEP.

When you configure one Multi-SSID, you must click Save to Table and then click
Apply to save your settings.
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Advanced > Multi-SSID > WEP Encryption

Key Type:
Key Size:

Key:

Select HEX or ASCII if you are using WEP encryption.
Select 64-, 128-, 152-bits

Select the 1st through the 4th key to be the active key. Enter the
key here.

Note: If any of the SSID uses WPA, WPA2, WPA-Auto, it will take
the space of key2 and key3. The rest can only use key1, key4, no
security, or use WPA also.

Advanced > Multi-SSID > WPA-Personal, WPA2-Personal, &
WPA-Auto-Personal

Cipher Type:

Group Key Update
Interval:

PassPhrase:

-
D-Link
Building Networks for People

A/r Premier”
2.4GHz Wireless Access Point with PoE

DWL-3200AP
| Home [T ER Tools Status Help

Enable Wulti-35ID [J Enable WLAN State
Performance
Band

 Fiter Index . |
SSID ‘ |

Security ir\ﬁﬁArPergoE\' v}
DHCP Server —

VLAN 1D [ |

PassPhrase Settings

Multi-SSID Cipher Type |AUTO ¥|  Group Key Update Interval [1800 |

EEE

PassPhrase |passpass |
Regue AP
Save to table
Mulit-SZI0
VLAN
Index SSID Band Encryption D Del
Prirnary default 11y OFF OFF
Mult-S5ID1 MSSID1 g | WPAPersona I [ofF [

@ 90

Apply Cancel Help

When you select WPA-Personal, please select AUTO, AES, or TKIP
from the pull down menu.

Select the interval during which the group key wll be valid. The
default value of 1800 is recommended.

When you select WPA-Personal, please enter a PassPhrase in
the corresponding field.
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Advanced > Rogue AP
D-Link

Building Metworks for People

Ar Premier”

2.4GHz Wireless Access Pointwith PoE

-m Advanced | Tools Status Help

Roqgue AP Detecti

erfnrmlnl:e ESsives

OapBgs OadHoo @ Both

I Filter Eang
11w F11g

BHCP Server Security

[Florr  [Fwer  [FlwPa-Enterprise  [MwPa-Personal  [#]wWPAZ-Enterprise

B . :
Multi-SSID [“lwraz-Fersonal  [¥lwPA-Auto-Enterprise  [¥]WPA-Auto-Personal

=

Rogue AP List
Rogue AP 8

Type CH BSSID Security MODE SsIiD
|APBSS |1 | OOO4BSfGcBe | WEP  0211g|  gamdal
|1 | ooft2zazzzaz | OFF  g02MMg|  AP2SO0-22

[apBss [1 [oo13dearsons | wer  [pozt1g|  mlounge
[apBss |6 [ooirosenacss | oFF  fozitg|  deteut
[adroc [6 [ e7o7smran | oFF  jBo2tib|  eciphosrd
APBSS | 6 | DD0deSehans | TN ja02i1g|

AP List

Type CH BSSID Security MODE SsSIiD Del

9 OO

Apply Cancel Help

BSS Type: | The Basic Service Set Type allows you to select from AP BSS, Ad
Hoc, or Both.

Band: | Select the type of network (bands 11b and 11g) that you would like
the AP detection to search on.
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Advanced > Rogue AP (continued)

Security:

Rogue AP List:

AP List:

Select the Security type OFF, WEP, WPA-Enterprise, WPA-Personal,
WPA2-Enterprise, WPA2-Personal, WPA-Auto-Enterprise, and
WPA-Auto-Personal that you would like to consider during AP
detection.

This window shows all of the neighbor APs detected, which is based
on your criteria from above (BSS Type, Band, and Security). If the
AP is in the same network, or if you know the AP, just click on “Add”
to save it to the AP list.

This window shows all of the APs that are allowed access on the
network.
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Tools > Admin

D-Link

“AsmrPremier”
2.4GHz Wireless Access Point with PoE
DWL-3200AP — "
ﬂ U OMM, Status___Help |
Administrator Settings
User Name h é::.gdmin .
A Old Password .

Mew Password
' System Confirm MNew Password

==
-
p—
aiical
J—
—

' Firmware o 9 O

Apply Cancel Help

Cfg File

Misc.

User Name: | Enter a user name. The default setting is admin.
0ld Password: | To change your password, enter the old password here.

New Password: | Enter your new password here.

Confirm New
Password:  Enter your new password again.
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Tools > System

D-Link

Building Metworks for People

AmrPremier”
2.4GHz Wireless Access Point with PoE

DWL-3200AP .
E R Status____Help |

' Admin

System Name |D-Link Access Point
System a Q c
Apply Cancel Help
' Firmware Apply Settings and Restart

{08

Cfg File

Misc Restore factory settings

System Name: | You can change the system name here for SNMP and AP Manager
use.

Apply Settings and | Click Restart to apply the system settings and restart the
Restart: | DWL-3200AP.

Restore to Factory | Click Restore to return the DWL-3200AP to its factory default
Default Settings: | settings.
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Tools > Firmware
D-Link

Building Networks for People

ArPremier”
2.4GHz Wireless Access Pointwith PoE

DWL-3200AP = =
‘ (O Status____Help |

ydate Firmware From Local Hard Drive

Firmware Version: v2.20

Update File | | [Browse—] [.9KJ

' System o

Help

' Admin

Firmware

gl

: Cfg File

Update File: | After you have downloaded the most recent version of the firmware
from http://support.dlink.com to your hard drive, you can Browse
your hard drive to locate the downloaded file. Select the file and click
OK to update the firmware.
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Tools > Cfg File
D-Link

Building Networks for People

“A/rPremier”

2.4GHz Wireless Access Pointwith PoE

[_Home __ Advancedil "N Status ___Help

—

Update File | |[_Browse.. ]

System Load settings to Local Hard Drive

' Firmware Help

UL

Cfg File

Misc.

I

SNTP

Update File: | Browse for the configuration settings that you have saved to your
hard drive. Click OK after you have selected the settings file.

Load Settings to the
Loacl Hard Drive: | Click OK to save the selected settings to your hard drive.
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Tools > Cfg File > Choose file

| Choose file

Loal in: I L} My Documerts _:_I - £ B~
- @My Music
@My Pictures
My Recent EMY Videos
Documents @
(&
Desktop
My Documents
My Computer
My Metworl: Filz name: lfile.dc:f .li Open
Places
Flesoftype:  [AllFiles (*) = Cancel

|

When you click Browse in the previous screen, the dialog box shown above appears.
Select the file you wish to download and click Open. Click OK to begin loading.

F .
D-Link
Building MNetworks for Feople

“AirPremier”

Settings saved.
The device is restarting.

Please wait for |1 seconds.

Click Restart for the settings to take effect. The dialog box above will appear as the
device restarts. Please wait for a few seconds.
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Tools > Misc > Telnet Settings

il
il
sl
e

I sNTP

System

Firmware

' Cfg File

Misc.

D-Link

Building Networks for People

“A/irPremier”

2.4GHz Wireless Access Point with PoE

[__Home __ Advancediiille """ Status____Help

|

Telnet Settings

Status Enahble

Caonsole Pratocol @ Telnet O 55H
Tirneout | IMing %

SHMP Settings

Status [] Enable

Public Community String

Private Community String

@ 90O

Apply Cancel Help

Telnet is a program that allows you to control your network from a single PC.

Status:

Console Protocol:

Timeout:

Telnet is enabled by default.
Choose between Telnet and SSH.

Select a time period after which a session timeout will occur.

Tools > Misc > SNMP Settings

Status:

Public Community
String:

Private Community
String:

Click Enabled to support SNMP. SNMP is disabled by default.

When SNMP is enabled, you can change the Public Community
Name here.

When SNMP is enabled, you can change the Private Community
Name here.
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SNTP/NTP Server Settings

D-Link

Building Metworks for Feople :-A ’F pl‘ emler‘w
2.4GHz Wireless Access Pointwith PoE
DWLHi)ﬂAP

[ _Home _ Advancedfilll PO Status ___Help |

il

SNTP/NTP Information
SHNTR/NTP Server IP

ST
" Admin
SNTP/MTP Time Zone (GMT) Greenwich Mean Time : Dublin,
Edinburgh, Lisbon, London
— )
SNTPINTP Setting
SNTR/NTP Server IP
e
* Firmware
SNTP/NTP Server Time Zane
——— | (GMT-08:00) Pacific Time (US & Canada); Tijuana vl
Cfa File Bl oliFa ' D Bl st bt o el el g e Y
g Daylight Saving Time [ Enabled

9 9O

Apply Cancel Help

Misc.

-

SNTP

SNTP/NTP | The time server IP address, time zone, and the local time will be
Information: | displayed here.

Server IP Address: | Enter the IP address of a SNTP/NTP server.
Time Zone: | Select your time zone from the drop-down menu.

Daylight Saving | Check the box to enable daylight savings time.
Time:
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Status > Device Info
D-Link

Building Networks for People :—A I,‘ pre. . .lerw
2.4GHz Wireless Access Point with PoE

Home Advanced 'Tools Status m

-

1 Firmware Version: v2.20
| MAC Address: 00:11:95:c7:f6:28
; Ethernet
ST AT Get IP From: Manual
IP address: 192.166.0.50
Subnet Mask: 2552552550
I Client Info Gateway: 0.0.0.0
Wireless (802.11g)
SSID: dlink
Channel: 6
Super G Mode: Disabled
Rate: Auto
Security Level: Open System / Encryption Disabled
L+
Help

Device | This window displays the settings of the DWL-3200AP, the firmware
Information: | version and the MAC address.
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Status > Stats
D-Link

AirPremier”

2.4GHz Wireless Access Point with PoE

Home Advanced Tools Status m

WLAN 802.11G Traffic Statistics

Throughput
Transmit Success Rate 84 %
: Transmit Retry Rate 0 %
Stats | Receive Success Rate 0 %
Receive Duplicate Rate 0 %
RTS Success Count 0
RTS Failure Count 94
Transmitted Frame Count
R T Transmitted Frame Count ]
Multicast Transmitted Frame Count 0
Transmitted Error Count 1
Transmitted Total Retry Count 0
Transmitted Multiple Retry Count 0
Received Frame Count
Received Frame Count 0
Multicast Received Frame Count 0
Received Frame FCS Error Count 94
Received Frame Duplicate Count 0
Ack Rey failure Count 16
WEP Frame Error Count
WEP Excluded Frame Count 0
WEP ICV Error Count 0

@0

Refresh Help

WLAN 802.11G | This window displays the statistics of the IEEE 802.11g network.
Traffic Statistics:
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Status > Client Info

D-Link

Building Metworks for People

Device Info

Client Info

()]

Lo

g

Client Information:

WDS Information:

A Premier”
2.4GHz Wireless Access Point with PoE

-

Advanced Status

on 0 station(s)

Home Tools

Power Saving

Authentication Mode

SSID | MAC | Band Signal

wne i
D

S Information 0 station(s)

| sSID | MAC | Band |  Authentication | Signal | Channel

Information on wireless clients will be shown here. A client is a device
on the network that is communicating with the DWL-3200AP with a
wireless connection.

This will display the WDS information when in WDS with AP and
WDS modes.

The following information is available for each client that is communicating with the

DWL-3200AP.

MAC:

Band:
Authentication:
Signal:

Power Saving
Mode:

Channel:

Displays the MAC address of the client.

Displays the wireless band.

Displays the type of authentication that is enabled.

Indicates the strength of the signal

Displays the status of the power saving feature.

Displays the channel of the WDS link.
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Status > Log
D-Link

Building Networks for People

AirPremier”
2.4GHz Wireless Access Point with PoE

Home Advanced Tools Status I!Ef_

i

EVIOUS LastPage lClear” Log Server J
o
‘Device Info

Page 1 of 1

Time Type Message
[r— WED MAR 15 15:40:24 Systemn  —-AP cold start with fiw version: v2.20
Stats 2006

WED MAR 15 15:40:25 Wireless —-WLANT Mormal AP ready

2006
[ Client Info ‘;'\[:]'Igg] MAR 15 15:40:41 System  —-Web login success from 192.168.0.166

Log

The log information will include, but not limited to, the following items:

o Upgrade Firmware
° Client associate and disassociate with AP
o Web login

Log Server: | If you require more space to hold your logs, please provide the IP address

of the Server that will store your logs. The embedded memory can only

have up to 300 logs.

Log Server/IP
Address: | Enter the IP address of the log server.

Log Type: | Check the box for the type of activity you want to log. There are three
types: System Activity, Wireless Activity, and Notice.
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Help
D-Link

Building Metworks for People :-A IP pl.‘ emlerw
2.4GHz Wireless Access Point with PoE

Home  Advanced  Tools Status Help |

Home

« Setup Wizard
+ Wireless Setlings

+« LAN Settings

Advanced
+« Performance
» Filter
« DHCP Server
« Muli-SSID

+« Rogue AP

Tools
« Administrator Settings
+ System Seftings
+ Firmware Upgrade
+ Configuration File
+ Miscellaneous
+« SNTP

Status
+ Device Information
+ Stafistics
+« Client Info

+ Log

FAQs

Help: | Click on any item in the Help screen for more information.
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Using the AP Manager

The AP Manager is a convenient tool to manage the configuration of your network from a
central computer. With AP Manager there is no need to configure devices individually.

To launch the AP Manager:
* Go to the Start Menu
* Select Programs
* Select D-Link AirPremier AP Manager
* Select DWL-3200AP

Discovering Devices

L

Click on this button to discover the devices available on the network.

Exist | Model Name MAC Address IF Address Netrmask Fiw/ Version | Dewvice Name Action Status
v Dwl-32004F  O01195C7FE28 192168050 2552552850 w220 D-Link Access Point

(Discover the devices

Discovering devices...

D-Link AirPremier AP Manager

Action Message
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Selecting Devices

The AP Manager allows you to configure multiple devices all at once. To select a single
device, simply click on the device you want to select. To select multiple devices, hold
down the Ctrl key while clicking on each additional device. To select an entire list, hold
the Shift key, click on the first AP on the list and then click on the last AP on the list.

IP Configuration

You can assign an |IP address to an AP or assign IP addresses to multiple
AP’s by clicking on this button after selecting the device(s).

| M arne MAC Address IP Address Netmazk Ffad Wersion | Device Mame Action Status
DwWL-32008F  OO119BCYFE2E8 152168050 255.255.2860 ¥2.20 D-Link Acoess Point - Put SMTP oK

IP Addiese _ 188 0 GO

IP Netmask 285 255 785 0
Ok Cancel

D-Link AirPremier AP Manager

Aclion Message

Select the AP that you want to assign an IP address to and click the IP button. Enter
the IP address and IP netmask for the selected device and click OK.

You can configure multiple AP’s with IP addresses all at once. Click on the IP button
after you've selected all of the AP’s you want to assign an IP address. Enter the IP
address you want to assign the first unit and the AP manager will automatically assign
sequential IP addresses.

D-Link Systems, Inc. 95



DWL-3200AP User’s Manual

Using the AP Manager

Device Configuration

B
I

Click on this button to access the configuration
properties of the selected device(s).

The device configuration window allows you to configure settings but does not actually
apply the settings to the device unless you click the Apply button. You can also save
and load configuration files from this window. When you load a configuration file, you
must click Apply if you want the settings to be applied to the selected device(s).

You can configure a single device by highlighting one device in the list, or you can
configure multiple devices by highlighting multiple devices before clicking on the Device
Configuration icon pictured above. The examples in this section show single device
configuration. When you select multiple devices for configuration the procedure will be

similar.

Check All

Clear Checks

Hefresh

Apply

Open

Cave

E =it

The Check All button will select all configurable options. Any setting
that has a checkmark next to it is applied to the device or saved to
the configuration file.

The Clear Checks button deselects all configurable options. This
feature is useful if you only want to change a few settings. Deselect
all items and only check the items that you want to modify.

Refresh will revert to the actual device settings of the selected
device(s).

To save settings to the device, you must click the Apply button. Only
settings that have a checkmark next to them will be applied.

The open button is used to load a previously saved configuration file.
After opening a configuration file, you must click the Apply button to
save the settings to the selected device(s).

The save button allows you to save a configuration file of the selected
device settings. Only settings that have a checkmark next to them
are saved. You cannot save a configuration file if you selected more
than one device in the device list.

The Exit button will close the device configuration window. Any
settings that haven’t been applied will be lost.
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e Device Conniguration

General | ‘Wireless Security Filter AP Mode DHCF Server Client Info Fiogue AF Log i
v Device Mame |D-Link Access Point
LAN
P Addess | I Gateway |
Subret Mask | ¥ DHCF Client | Disable -]
v Telnet Suppart
Telnet
Telnet Timeout |3 j [s] Console Protocol: Telnet j
SMMF Setting
Status | Disable ~]
Public: Community String |
Private Conmunity String |
Check Al | Clear Ehecks| Refresh | Apply | Open Save E xit

Device Configuration > General

Device Name(*):

IP address and
Subnet Mask(*):

Gateway:

When selecting multiple devices for configuration, some options are
unavailable for configuration by default as noted(*) below:

This allows you to change the device name for the selected
access point. You must place a checkmark in the Device Name
box to change the name. This option should only be configured
when one access point is selected for configuration.

If you've selected one device for configuration and you want

to change the IP address of the device, check the IP Address
box. You ca then enter an IP address and Subnet Mask for the
selected access point. This option should only be configurable
when one access point is selected for configuration. To configure
multiple devices with an IP address at one time, please reference
the previous page.

Enter the IP address of your gateway, typically your router
address.
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Els

Device Configuration > General (continued)

DHCP client:

Telnet Support:

Telnet Timeout:

Console Protocol:

Status:

Public Community
String:

Private Community
String:

There is a pulldown menu to select enabled or disabled. When
enabled, the selected device(s) will function as a DHCP client(s).
This allows them to receive IP configuration information from a DHCP
server. When disabled, the access point(s) must have a static IP
address assigned to them.

This pulldown selection enables or disables the ability to Telnet into
the selected device(s).

This pulldown selection defines the timeout period during a Telnet
session with the selected device(s).

Select either Telnet or SSH from the pulldown.

Click Enabled to support SNMP. SNMP is disabled by default.

When SNMP is enabled, you can change the Public Community
Name here.

When SNMP is enabled, you can change the Private Community
Name here.
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Device Configuration > Wireless

X Device Conriguration X
General |m Security Filter AP Mode DHCP Server Client Info | Rogue AP Log ﬂL
IEEEB02.11g
v “Wireless Setting
s3I0 [dink Data Fiate |t =]
Chahinel i—_| Beacon |nterval (2071 000] 100
531D Broadcast [Enable =] DTIM[1~255) [
SuperG [Disable ~l Fragment Length [266~2346] (2345
Radic On - RTS Length [256~2346) |zass
Preamble |Shu:|rt and Long :J T Poweer |Full i
‘Wireless B/G Mode iMi:-:ed _vJ Auto Channel Scan |Enable l]
b b Im Antenna Diversity W
| Clear Eheck$| Refrezh I Lpply I Open Save E=it

Wireless:
SSID:

Channel:

SSID Broadcast:

Super G:

Radio Wave:
Preamble:
Wireless B/G Mode:

WMM:

Check to enable wireless mode.

The Service Set (network) Identifier of your wireless network.
Allows you to select a channel. 6 is the default setting (see Auto
Channel Scan on the next page).

Allows you to enable or disable the broadcasting of the SSID to
network clients.

Select this option to enable a wireless signal rate of up to 108Mbps.
Select On or Off.

Select the default value Short and Long, or Long Only.

Select Mixed, 11G Only, or 11B Only.

Select Enable or Disable, Disable is selected by default. WMM
stands for Wi-Fi Multimedia, by enabling this feature it will improve
the user experience for audio and video applications over a Wi-Fi
network.
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Device Configuration > Wireless

Date Rate: | A pulldown menu to select the maximum wireless signal rate for the
selected device(s).

Beacon Interval | Beacons are packets sent by an access point to synchronize a
(20~1000): | network. Specify the beacon value for the selected device(s) here.
The default value of 100 is recommended.

DTIM (1~255): | DTIM (Delivery Traffic Indication Message) is a countdown informing
clients of the next listening window for broadcast and multicast
messages.

Fragment Length | This sets the fragmentation threshold (specified in bytes). Packets
(256~2346): | exceeding the value set here will be fragmented. The default is 2346.

RTS Length | The RTS value should not be changed unless you encounter
(256~2346): |inconsistent data flow. The default value is 2346.

Tx Power: | A pulldown menu for selecting the transmit power of the selected
device(s).

Auto Channel | Select this option to automatically select the most optimal channel
Scan: | available for wireless networking (default for AP mode).

Antenna Diversity: | The DWL-3200AP supports 2.4GHz radio with two antennas. Radio
is connected to each antenna and supports auto diversity mode by
default. This means that the access point will auto switch to the
antenna with better RSSI value.

Diversity: The DWL-3200AP will auto switch to the antenna with
better RSSI value.

Left Antenna: The AP will not switch antenna and the radio will
use the left antenna (when facing the AP) to transmit and receive
packets.

Right Antenna: AP won’t switch antenna and the radio will use
the right antenna (when facing the AP) to transmit and receive
packets.

*Maximum wireless signal rate derived from IEEE Standard 802.11g specifications. Actual data throughput will vary. Network
conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead,
lower actual data throughput rate. Environmental factors may adversely affect wireless signal range.
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Device Configuration > Security > Authentication

8 Device Configiration

General | Wirelezz | Security | Filter | AP Mode | DHCP Server Client Info Rogue AF | Log il
WEF Key |
—I[EEES02.11g
v .ﬁ.uthenticatiuniﬂpen
E H Shared
HED R Open System_.-’Shared Key
&ctive Fey [nd WHPA-Enterprize
WRA-Perzonal
1zt Key WRAZ-Enterprize
WhRAZ-Perzonal
2nd Kep WRA-AULD-E nterprise
WhPA-ALo-Personal
rd Key I!';ia'i. _lI! HE=
dth Key |54 xlfHEX
Check All Clear Checks Fefrezh Apply Open Save E xit
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Device Configuration > Security > Authentication (continued)

AP Mode

Access Point

WDS with AP

WDS

Authentication Available

Open System

Shared Key

Open System/Shared Key
WPA-Enterprise
WPA-Personal
WPA2-Enterprise
WPA2-Personal
WPA-Auto-Enterprise
WPA-Auto-Personal

Open System

Shared Key

Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

Open System

Shared Key

Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

Select Open System to communicate the key across the network.
Select Shared Key to limit communication to only those devices that share the same

WEP settings.

Select Open System/Shared Key to allow either form of data encryption.

Select WPA-Enterprise, WPA2-Enterprise, or WPA-Auto-Enterprise to secure your
network with the inclusion of a RADIUS server.
Select WPA-Personal, WPA2-Personal, or WPA-Auto-Personal to secure your net-
work using a password and dynamic key changes.
(No RADIUS Server required).
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Device Configuration > Security > Open and Shared

(@ Device Configuration "=
General | ‘Wireless ,lm Filter _ AP Mode DHCF Server _ Client Infa | Fogue AF Log ﬂ;
WEP Key ]

-IEEEB0Z211g
v ﬂuthenticatiun]ﬂpen j
Encyption JEnabIe :J
Active Key Index
13t Kep |54 _:_” _H """
nd Key | _“ J | ..........................
3rd Key | . _“ _H ................

Ath Key |-|52 __"'_H."—".SC” _:__j | xxxxxxxxxxxxxxxx

Check Al I Clear Checks| Fefrezh I Apply I Open J Save ‘ Euit I

The Security tab contains the WEP configuration settings on the intial page. If you select

WPA as the authentication type, an additional tab will appear with the WPA configuration
options based on your selection.

Authentication | Select from the pulldown menu the type of authentication to be used
Type: | on the selected device(s).

Encryption: | Enable or disable encryption on the selected device(s).
Active Key Index: | Select which defined key is active on the selected device(s).

Key Values: | Select the key size (64-bit, 128-bit, or 152-bit) and key type (HEX
or ASCII) and then enter a string to use as the key. The key length
is automatically adjusted based on the settings you choose.
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Device Configuration > Security > WPA-Enterprise, WPA2-Enterprise,

& WPA-Auto-Enterprise

= Device Configuration

General Wirelezs Security | Filter AP Mode DHCP Server Client Infa | FRogue AP Log il
WEP Key IEEEBDE.11QWF‘.&|
i
WFA setting
Cipher Type | Auto -
Group Key Update [nteryval !1800 [300 - 9999939)
PassFhiase | (8 - £3 chars]
: S.ec.urity Server
RADIUS Server | o 0 0 0 Accounting Mode |Di$ahle LJ
RADIUS Port [1-65535] 1812 fecountingSever 0 0 0 0
RADIUS Secret I Accounting Port ] d
Check All I Clear Ehecks| Refrezh I Apply I Open | Save E st

Cipher Type:

Group Key Update
Interval:

RADIUS Server:

RADIUS Port:
RADIUS Secret:
Accounting Mode:
Accounting Server:

Accounting Port:

Select Auto, AES, or TKIP from the pulldown menu.

Select the interval during which the group key will be vaild. 1800 is the
recommended setting. A lower interval may reduce transfer rates.

Enter the IP address of the RADIUS server.

Enter the port used on the RADIUS server (1812 is default).
Enter the RADIUS secret.

Select if you want to use a different server for accounting.
Enter the IP address of the Accounting server.

Enter the Accounting port (1813 is default).
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Device Configuration > Security > WPA-Personal, WPA2-Personal,
& WPA-Auto-Personal

(. Device Configuration =
General | Wireless Securty | Filter AP Mode DHCF Server Cliert Infa | Rogue AF Log 4| ¥
WEP Key IEEEB0211g'WP4 |

v

P zething
Cipher Type | Auta -
Group Key Update Interval !'I ann [300 - 3933939)
PazsFPhrase || (3 - 63 charg]

Check All J Clear Ehecks| Refrezh ‘ Apply ‘ Open ‘ Save E st

Cipher Type: | Select Auto, AES, or TKIP from the pulldown menu.

Group Key Update | Select the interval during which the group key will be valid. 1800 is the
Interval: | recommended setting. A lower interval may reduce transfer rates.

PassPhrase: | Enter a PassPhrase between 8-63 characters in length.
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General

YWireless
WLAN Partition

IEEES0211g

v Internal Station Connection Enable v]
v Ethemet bo'WLAN Access Enable -

IEEEB0211g Access Setting

v Access Contral

ACL MAC Address

|00:00:00:00:00:0 Add| Del

Security Filter AP Mode DHCP Server ClentInfo | Fogue AP Log il

Check Al | Clear Ehecks| Refresh I Apply | Open | Save | Euit I

Internal Station
CGonnection:

Ethernet to WLAN

Access:

Access
Control:

Access

Enabling this allows wireless clients to communicate with each other.
When this option is disabled, wireless stations are not allowed to
exchange data through the access point.

Enabling this option allows Ethernet devices to communicate with
wireless clients. When this option is disabled, all data from Ethernet
to wireless clients is blocked. Wireless devices can still send data to
the Ethernet devices when this is disabled.

When disabled access control is not filtered based on the MAC
address. If Accept or Reject is selected, then a box appears for
entering MAC addresses. When Accept is selected, only devices
with a MAC address in the list are granted access. When Reject
is selected, devices in the list of MAC addresses are not granted
access.

Control List:  Add or Delete MAC addresses in the Access Control List.
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Device Configuration > AP Mode

S Device Configuration g°9|
General | ‘whieless Securnty Filter AP Mude DHCP Server Cliert Infa | Rogue AP ' Log 4|

IEEE202.11g

¥ AP Mods  |accessPont ]

Check Al Clear Checks R efrezh Apply Open Save E wit

Access Point: | There are 3 AP modes:

Access Point
WDS with AP
WDS

Please see the following pages for an explanation of the other 2 AP
modes.
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Device Configuration > AP Mode > WDS with AP

(& Device Configuration

General | wirsless | Security | Filker AP Made | DHCP Server | Client lrfa | Rogue AP ' Lag 41 ;]

IEEEB0Z11g
v AP Mode WADS with AP
Remaote AP MAC Address

00:00:00:00:00:00 ﬂddj Del

[ 5ite Survey

55ID [ BssID [l
£ w ] B3
Site Survey 1
Check All Clear Ehecks] Refregh ] Apply Open Save I E xit

WDS with AP: | Allows you to connect multiple wireless LANs together, while still
functioning as an AP. If enabled, you may either enter the MAC
address of the other DWL-3200APs or click Site Survey and add
APs from there.
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Device Configuration > WDS

1% Device Configuration

General | Wireless | Security | Filter | AP Made | DHEP Server Client Info Rogue &P | Loa 4| |

-IEEEB0Z11g i

v AP tode

Remaote AP MAC Address

|00:00:00:00:00:00  Add]| Dell

—Site Survey

[
55ID | BSSID [ ]
<] i | (2]
Site Survey '
Check All | Clear Ehecksl Refresh l Apply | Open | Save | E wit l

WDS: | Allows you to connect multiple wireless LANs together. All other LANs
must be using DWL-3200APs. When enabled, you may either enter
the MAC address of the other DWL-3200APs or click Site Survey
and add APs from there.
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Device Configuration > DHCP Server

Disable =

Subkazk
Gateway
Witz
DHS

Domain M ame

Statuz

Check Al | Clear Checks|

IP Azzigned From: 1 _J _J J
Ranage of Paool [1~255])C
I—
Leasze Time[B0~31536000 zec] |L

= Device Configuration x|
General | ‘Wireless | Securty | Filter AP Mode DHCF Server | Clientlnfo | RoguedP | Log 4| »

=L

MALC Address | IP Address [ Status |

Fefrezh ‘ Apply | Open | Sawve | Exit ‘

DHCP Server:

Dynamic Pool
Settings:

Static Pool
Settings:

IP Assigned From:
Range of Pool (1~255):
SubMask:

Gateway:

Wins:

DNS:
Domain Name:

Lease Time:
Status:

Enable or disable the DHCP server function.

Click to enable Dynamic Pool Settings. Configure the IP address
pool in the fields below.

Click to enable Static Pool Settings. Use this function to assign the
same IP address to a device at every restart. The IP addresses
assigned in the Static Pool list must NOT be in the same IP range
as the Dynamic Pool.

Enter the initial IP address to be assigned by the DHCP server.
Enter the number of allocated IP addresses.

Enter the subnet mask.

Enter the gateway IP address, typically a router.

Wins (Windows Internet Naming Service) is a system that determines
the IP address of a network computer with a dynamically assigned
IP address, if applicable.

The IP address of the DNS server, if applicable.
Enter the domain name of the DWL-3200AP, if applicable.

The period of time that the client will retain the assigned IP address.

This option turns the dynamic pool settings on or off.
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Device Configuration > Client Info

(& Device Configuration X
General | Wireless Security Fiter | AP Mode DHCF Server I:Iientlnf Rogue AF Log 4| ¥
Cliert Infarmation

MAC Address Band Authentication | RSS! | PowerMode | 551D
WS |nfarmation
MaC Address | Band | Authertication | RSS! | Channel | 551D
Client Info |
Clear Ehecks] Refresh Apply ] Open ‘ Save E xit ‘

Client Information: | Information on wireless clients will be shown here. A client is a device
on the network that is communicating with the DWL-3200AP with a
wireless connection.

WDS Information: | This will display the WDS information when in WDS with AP and
WDS modes.

MAC Address: | Displays the MAC address of the client.
Band: | Displays the wireless band.
Authentication: | Displays the type of authentication that is enabled.
RSSI: | Indicates the strength of the signal.
Power Mode: | Displays the status of the power saving feature.

Channel: | Displays the channel of the WDS link.
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Device Configuration > Rogue AP

General Wireless S ecLrity Filtker AP Mode DHCP Server Client Infa | Fogue AP Log FR Y
Fogue AF Detection
BSS Type: [~ APBSS " AdHoc " Bath
Band: [ 11b [ Mg
Securiby [ OFF [~ WEF [ WhRAEnterprize [ wPA-Perzonal
[ WPAZ-Enterprize [ WPaZ2-Perzonal
[ wilPd-duta-Enterprize [ wha-Auto-Personal
Fiogue AF List: AP List:
S5I0 1 BSSID S5I0 BSSID
&
Del
4 2 ¢ »
Detect
Clear Checks | Refresh ‘ Apply Open Save | Exit ‘

: | The Basic Service Set Type allows you to select from AP BSS, Ad
Hoc, or Both.

Band: | Select the type of network (bands 11b and 11g) that you would like
the AP detection to search on.

Security: | Select the Security type OFF, WEP, WPA-Enterprise, WPA-Personal,
WPA2-Enterprise, WPA2-Personal, WPA-Auto-Enterprise, and
WPA-Auto-Personal that you would like to consider during AP
detection.

Rogue AP List: | This window shows all of the neighbor APs detected, which is based
on your criteria from above (BSS Type, Band, and Security). If the

AP is in the same network, or if you know the AP, just click on “>” to
save it to the AP list.

AP List: | This window shows all of the APs that are allowed access on the
network.
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Device Configuration > Log

(& Device Configuration

General

Wireless Security Filker AP Mode DHCF Server Client Infa | Rogue AF 4| ¥
| Remote Syslog Status:
Syztern Achivity Enable 3 Wwireless Activity: Enable 3 Matice JEnaI:uIe j"
Remote Syzlog Status Server IF; ] [ Lag
Tirne | Type ] Meszage

| ptime O day 00:00:07 WIRELESS -wLAMT Mormal &P ready

|Iptirne O day 00:00:071 Y5 4P cold start with FAw vergion: w220

%] Il J [

Clear
Check All J Clear Ehecks| Refresh ‘ Apply ‘ Open ‘ Save | E xit ‘

RemoteSyslogStatus:

System Activity:

Wireless Activity:

Notice:

Remote Syslog
Status Server IP:

Check this option to enable the log and the Remote Syslog Status
Server IP.

Select Enable to allow the logging of system actions, such as logging
a firmware upgrade.

Select Enable to allow the logging of any wireless clients that connect
to the AP.

Select Enable to allow all other information to be logged.
If you require more space to hold your logs, please provide the

IP address of the Server that will store your logs. The embedded
memory can only have up to 300 logs.
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Device Configuration > Multi-SSID

= Device Configuration

Filker AP Maode | DHCP Server Client Info Rogue AF Log | RIS S0 SHTP 4| ¥
v Enable Mult-5510 [ Enable VLAM State
kulti-S510 Setting
Band 1802119 v] sgip  |dink7 VLA D |
MSSID Index  |MSSIDE - SEDrurit}']WF‘.-’-‘-.-.-’-‘-.utl:n-F'ersnnal _:_]
~PazzPhrasze Setting
Cipher Tppe Auto - Group Keyp Update Interval [300- 3933933) ]1 800
PazzPhrase 1xxxxxxxxxxxxxxxxxxxxxx (8 - B3 chars]
RaDIUS Server I 2SS | R | Accounting Mode | izable J
RADIUS Port  |1512 [1-65535] Accounting Server) 0 0 0 O
RaDlUS Secret | Accounting Part | i
MSSID Index | 551D | Band | Encryption | WLAN D |
Primany dlink. g WFA-ALUto-Perzonal 1]
MSSI0T dlink.2 g Shared 1]
MSSIDZ dlink3 Mg WHEA-Persanal 1]
M5S0 dlink.4 Mg WPAZ-Perzonal 1]
MSSI04 dlink5 11g Dpen 1]
MSSID5 dlinkg 11g Shared 1]
MSSIDE dlink ¥ g WRA-Auto-Perzonal 1]
MSSIDT dlinka 11g Mone 1]
Delete
Check All J Clear Ehecks| Refresh ‘ Apply ‘ Open | Save | E xit ‘

The DWL-3200AP offers configuration using Multiple SSIDs, allowing for a virtually
segregated station by sharing the same channel. One primary SSID can be associated

with up to 7 guest SSIDs. Because guest SSIDs

cannot be scanned by site survey

tools, users cannot associate with guest SSIDs unless they know the exact SSID and
security setting. The VLAN function can be enabled for both the primary SSID and the

guest SSID.

Click Save to add the MSSID setting to the table below. Highlight and click Delete to

remove the MSSID from the table.
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Device Configuration > SNTP

(& Device Configuration

Filker

AP Mode |

SHTP/MTP Infarmation
SHNTR/NTF Server IP ]

SHTR/NTE Time Zohe ][GMT] Greenwich Mean Time : Dublin, Edinburgh, Lisbon, Londaon

Local Time ]

SMTP/NTP Setting

SNTP/NTF Server IF ]EI B

SNTR/NTP Time Zane | (GMT) Greerwich Mean Time : Dublin, Edinburgh, Lisbon, Londan |

Daylight Save Time

Check &l | Clear Checks |

DHCP Server

SNTP |

Client Info Rogue AF Log Multi-SS1D

| Disable

E

Refresh J Apply I Open I Save | E «it I

SNTP/NTP
Information:

Server IP Address:
Time Zone:

Daylight Saving
Time:

The time server IP address, time zone, and the local time will be
displayed here.

Enter the IP address of a SNTP/NTP server.
Select your time zone from the drop-down menu.

Select Enable or Disable daylight savings time from the drop-down
menu.
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Configuration Files

The DWL-3200AP allows you to save the device settings to a configuration file. To save
a configuration file follow these steps:

B Select a device from the Device List on the main screen of the AP Manager.
m Click the device configuration button.

m Click the Save button after you have all the settings as you want them.

[

A popup window will appear prompting you for a file name and location. Enter the
file name, choose a file destination, and click Save.

bl Ela )
& LE! Lel

=] = _

= EI- E __LP\-" "\.i"-

F/wi Version | Device Name Aution
D'wL-32004P  O01195C7FE28  192168.050 255.255.255.0 ¥2.20 D-Link Access Point - Put SNTP Ok

" Fler | APMode | DHCPSewer | Clentlfo  RoguedP | Lo | MuliSSID [snTP | «[»

AirPremier
AP
Manager

SHTP/NTP Information

SNTP/NTR Server [P I

SNTPAMTF Time Zone i[GMT] Greenwich Mean Time : Dublin, Edinburgh, Lizbon, London

Local Time I

| Save coﬁﬁgurations file

I SHTP/NTF Setting

Sa\rein:!E)Conﬂg j e ¥ B
SNTRMTP Server IP ID ] [2Temp

SHTP/MTF Time Zone i[GMT] Greenwich Mean Time : Dul

Draplight Save Time ![).gab\e 'l

D-Link AirPremier AP Manager

Save I

File name: |

Action Message Save as type: I- - ;! Cancel |

Check Al Clear EhacksJ Riefresh Apply Open | Save I Exit
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To load a previously saved configuration file, follow these steps:

You must always click Apply
in the Configuration window if
you want the settings to take

effect.

Select a device from the Device List on the main screen of the AP Manager.
Click the device configuration button.
Click the Open button.

A popup window will appear prompting you to locate the configuration file. Locate
the file and click Open.

The configuration file is loaded into the AP Manager but has not actually been
written to the device(s). If you want to use the newly loaded configuration for the
selecte(d)device(s), click Apply and the configuration settings will be written to the
device(s).

& |

X o T

Device Configuration button.

Exist | Model Name MAC Address IF Address Netmask F/wf Version | Device Name Action Status
' DWw/L-32004F  OO119BC7FE28 192168050 2852852850 w220 D-Link Access Point Put SHTP Ok

Fiter | APMode = DHCPSever | Clentlnfo | RoguedP  Log | MuliSSID | [SNTP | «|»

SNTRINTP Infarmatior

SHNTP/NTP Server IP I

GHTEMTP Time Zone ;[GMT] Greenwich Mean Time : Dublin, Edinburgh, Lisbon, London

5 Local T |
ocal Time

g

s ’

E [ Save configurations file

< SHTP/NTP Setting

g Savein IE)CDnﬁQ _‘j - £ B

& SNTP/NTP Server IP I o o 0 0 [E=yTemp

é SNTRMTR Timezunei[GMT]Grsenwwch Mean Time : Dul

g Daylight Save Time ’D\sable vl

File name: | ‘ Save I
Action Message Save astype: |‘. ;i Cancel
=

Check &l E\earChecksJ Refresh ! Apply ! Open I Save ! E it !
V'
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Firmware

En

You can upgrade the firmware by clicking on this button after
selecting the device(s).

To upgrade the firmware:

m Download the latest firmware upgrade from http://support.dlink.com
to an easy to find location on your hard drive.

B Click on the firmware button as shown above.
® A popup window will appear. Locate the firmware upgrade file and

clickOpen.

IMPORTANT! DO NOT DISCONNECT POWER FROM THE UNIT WHILE THE
FIRMWARE IS BEING UPGRADED.
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System Settings

You can customize the basic System Settings for the
DWL-3200AP by clicking on this button.

Netmask. Fiw Version | Device Name Action
DWL-32008P  D01195C7FEZ28 1921B8.050 2552552550 w220 D-Link Access Point PutSNTP 0K
S System Setting =
D-Link Access Password |
AirPremier
AP
Manager Setting Timenout (5] 5
Reboot Time (] 25
Configuration Upload Time [3] a0
% Configuration Download Time (5] kil
% Configuration Flash Update Time [s] [
; Factory Reset Time [3] &0
E F/w Download Time [2] &0
E F## Flash Update Time [s] &0
.q: Timing Tolerance [5] 5
-E Dizcovery Timeout [3) 5
E; Dizcovery Packets Number 1
Site Survey GetTime(s) a
Client Info GetTime(s) B
Auto Refresh | Dizable «| |10
Default QK Cancel
Action Message — I J o |
[ Access Password: This sets the admin password for the selected
device(s).
[ | Auto Refresh: This setting allows you to enable auto refreshing

of the network device list. By default this option is disabled. If you
choose to enable it, you must enter the refresh interval in seconds.

All other settings on this screen should be left at the default setting.
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Setup Wizard

m_%

This button will launch the Setup Wizard that will guide
you through device configuration.

Fi5 Wizard DWL-3200AP M=

Ilh'i'll -ﬂ"."’dllﬂi A i'rl

YWi'elcome to OWyL-3200AF Setup Wiizard. The Wyizard will gquide wou
through the four quick steps shown below, Begin by clicking Next .

atep 1.5etvour new password
otep £.3etthe 5510 and Channel (B0E2.11a)
otep 3.3t Encryption (80211 9)

otep 4. Restar

4 Prew Mext Exit

Click Next.
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Setup Wizard (continued)
m_%

Enter a Password and retype it in the Verify Password field.

Fis Wizard DWL-3200AP (M [s] X

DWIFESZOURPISCTUpN

Set Password

Y'ou may change the password by entering a new password |

Yerify the new passward.

Click Next to continue

Faszsword
Yerify Password l
< Prev L Mest Esit
Click Next.
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Setup Wizard (continued)

"4 Wizard DWL-3200AP

DWIEES ZUUAFISETD
Enter the SSID and the
Channel for the IEEE ) )
network. Set Wireless LAN 802.11g Connection
Enterthe 551D and Channel to be used for the Wireless LAN 802119
connection, Click Next to continue
SSID:  |dink
Channel: 1 ]
Click Next.
< Prev Exit I
%55 Wizard DWL-3200AP o
(VYL _'\'."'=I|l| N "h‘l_ﬂl'l'l
If you want to enable WEP Encryption for 802.11g
Encryption, enter the [fwouwish to use encryption, enable it here and enter the
Encryptlon values here. encryption key walues. Click Next to continue.
" Mo Security
. Key Size: B4 -
Fistkey /0000000000
© WRAPSK
Pazs Phrase:
Cipher Type: - | Group Key Update Interval:
Click Next. :
< Frew Next: Exit I
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Setup Wizard (continued)

Fis Wizard DWL-3200AP (M [E) <

I.illlll -ﬂ".‘l’j”ll i I'Fl

Setup Complete!

The Setup Wizard is completal Click Prew to modify the
previous settings. Click Finish to sawve the current settings and
restart the DWWL-3200AF.

< Prewv Exit

The DWL-3200AP setup is complete!
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Refresh

I = - G4
g | | 1 S -
' 1 o '.

Click on this button to refresh the list of
devices available on the network.

Devices with a checkmark %
next to them are still
available on the network.
Devices with an X are no
longer available on the
network.

D-Link AirPremier AP Manager

About

Click on this button to view the
version of AP Manager.

DL : D-Link AirPremier AP Manager
% Yerzion 1.15
Copyright 2005 D-Link. Corparatian,
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Networking Basics
Using the Network Setup Wizard in Windows® XP

In this section you will learn how to establish a network at home or work, using Microsoft
Windows® XP.

Note: Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000 for information about networking computers
using Windows® 2000.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Metwork Setup Wizard

Welcome to the Network Setup
% Wizard

Thiz wizard will help wou zet up this computer o run an pour
netwark. YWith a network you can:

Share an Internet connection

Set up Intemet Connection Fireweall
Share fileg and folders

Share a printer

L I

To continue, click Mest.

ue:-ct} |’ Cancel

When this screen appears, click Next.
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Please follow all the instructions in this window:

Metwork Setup Wizard
Before you continue. .. %

Before you continue, review the checklist for creating a nebworls,

Then, complete the following steps:

+ |nztall the network. cards, modems, and cables.

+ Turn oh all computers, printers, and external modems.
= Connect to the Intemet.

“When you click Mest, the wizard will search for a shared Internet connection on your nebwork.

< Back ” Mest » l[ Cancel

Click Next.

In the following window, select the best description of your computer. If your computer
connects to the internet through a gateway/router, select the second option as shown.

Metwork Setup Wizard

Select a connection method.

Select the statement that best dezcribes this computer:

() Thiz computer connects directly to the Intermet. The other computers on my network connect
ta the [nternet through this computer.

Wigw an example.

() Thiz computer connects to the Intermet through anather computer on my network. o through
a residential gatewan.

Wiew an erample.

Learn more about home or zmall office network, configurations.

< Back ” et » J[ Cancel

Click Next.
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Enter a Computer description and a Computer name (optional).
Network Setup Wizard
Give thiz computer a dezcription and name.

LComputer description: ‘ Mary's Computer |

Examplez: Family Room Computer or Monica's Computer

Camputer name: ‘ Office |
Examplez: FaMILY or MOMICA

The current computer name iz Office

Learn more about computer names and descriptions.

[ < Back ” Mewt = l[ Cancel

Click Next.

Enter a Workgroup name. All computers on your network should have the same
Workgroup name.

Metwork Setup Wizard

Hame your network.

Marmne your netwark by zpecifuing a workgroup name below, All computers o pour ketwork
zhould have the zame workgroup name.

YWorkgroup name: Accounting
Examples: HOME or OFFICE

< Back ][ Hest » ][ Cancel

Click Next.
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Please wait while the Network Setup Wizard applies the changes.

Network Setup Wizard

Ready to apply network settings...

The wizard will apply the fallowing settingz. This process may take a few minutes to complete
and canhot be intermupted.

Settings:
Metwork zettings:

Computer descriphan: Mary's Computer
Computer name;

Office
Wworkgroup name: Accounting

The Shared Diocuments folder and any printers connected to this computer have been
shared.

Tao apply these sethings, click Mest.

[ < Back ”_ Mest » |[ Cancel

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer. This may take
a few minutes.

Metwork Setup Wizard

Pleaze wait...

Fleaze wait while the wizard configures thiz computer for home ar zmall office netwarking. Thiz
process may take a few minutes.

L B
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In the window below, select the option that fits your needs. In this example, Create a
Network Setup Disk has been selected. You will run this disk on each of the computers
on your network. Click Next.

Network Setup Wizard

You're almost done___

®  You need ta run the Metwark Setup Wizard once on each aof the computers on yaur
;5) network. To run the wizard on computers that are not running Windows =P, you can uze
the Windows *P CD or a Metwork Setup Digk.

“WWhat do pou want to do’?

(®)iCreate & Metwark Setup Diski

() Use the Network. Setup Disk | already have
(") Use my Windows =P CD

() Just finish the wizard; | don't need to run the wizard on other computers

Insert a disk into the Floppy Disk Drive, in this case drive A.

Insert the dizk you want to use.

Inzert a dizk the into the following disk drive, and then click Mest.

3% Floppy [&:]

IF you want to farmat the disk, click Format Disk.

< Back “ Mests> |

Click Next.
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Copying...

9 -

Flease wait while the wizard copies files. ..

[ ) | Zancel

Please read the information under Here’s how in the screen below. After you complete
the Network Setup Wizard you will use the Network Setup Disk to run the Network
Setup Wizard once on each of the computers on your network. To continue click

Next.
Network Setup Wizand
To run the wizard with the Network Setup Disk_..

® + Complete the wizard and restart this computer. Then, use the Metwark Setup Disk ta run
‘1) the Metwork Setup wizard once on each of the other computers on vour netwaork,

Here's hiow:

1. Inzert the Metwork Setup Dizk into the nest computer you want to network,
2. Open My Computer and then open the Hetwaork Setup Dizk.
3. Double-chick "netsetup.”

[ < Back “ Nest> |

D-Link Systems, Inc. 90



DWL-3200AP User’s Manual Networking Basics

Please read the information on this screen, then click Finish to complete the Network
Setup Wizard.

Hetwork Setup Wizard

Completing the Metwork Setup
% Wizard

Y'ou have succeszsfully zet up thiz computer for home or zmall
office netwarking.

For kelp with home or gmall office networking, zee the
following topics in Help and Support Center:

+ Using the Shared Documents foldes
+ Shanng files and tolders

To zee other computers on your netwark, click Start, and then
click My Hetwark Places.

To close this wizard, click Finigh,

| <Back || Finish |

The new settings will take effect when you restart the computer. Click Yes to restart
the computer.

System Settings Change X
P You musk restart your computer before the new settings will take effect,
,\_-

Do you wank bo restart wour computer now?

You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network
Setup Disk on all your computers, your new wireless network will be ready to use.
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Naming Your Computer

To name your computer in Windows® XP, please follow these directions.

m Click Start (in the lower left corner of the screen).

B Right-click on My Computer.

B Select Properties and click.

___;? My Documents

Internet
Internet Explorer
""i E-mail

d Cutlook Express

b My Recent Documents #

_f} My Pictures

=B " cnrnand Prompk } My Music

L
\! MSM Explorer .._[ My Computer
Open

q My Network  Explore

e windows Media Player esip
‘ E’ Control Panel  Manage
WL Windows Mavie Maker

e Map Metwork Drive. ..
2 st L Disconnect Nebwork Drive, ,,
[@ Tour Windows $P -
:% Printers and F Show on Desktop
b | Files and Settings Transfer

Renarme
Wizard

t_’) Help and Sup| [N

B Select the Computer Name Tab in the System Properties window.

B You may enter a Computer Description if you wish; this field is optional.

B To rename the computer and join a domain, Click Change.

D-Link Systems, Inc.

System Properties

ﬁutuﬁm;afiﬁ U.pd;ates Il '.I':Eemcu-te
Advanced

?)X

Windows Lzes the fallowing infarmation ta identify your computer
on the network,

Computer description;

Far example: “Fitchen Computer or "Mary's
Computer''.

Full computer name:  Office

Whorkgraup: Accounting

To uze the Metwork [dentification wizard o join a
domain and create a local user account, click Metwork

Hetwork [D
ID.
Ta rename thiz computer ar join a domain, click Change.
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In this window, enter the Computer name.

Select Workgroup and enter the name of the Workgroup.

Click OK.

[ |

[ |

B All computers on your network must have the same Workgroup name.
[ |

Computer Name Changes

Computer name;

You can change the name and the memberzhip of this
computer. Changes may affect access to netwark resowrces.

[ Office

Full computer name:
Office

M ember of
() Damain:

(=) Workgroup:

' Accounting

OK

|[ Cancel l

Checking the IP Address in Windows® XP

The wireless adapter-equipped computers in your network must be in the same IP
Address range (see Getting Started in this manual for a definition of IP Address Range.)
To check on the IP Address of the adapter, please do the following:

B Right-click on the Local Area Connection icon in the task bar.

m Click on Status.

Disable

Fepair

Open Metwork Connections

Yiew Available Wireless Netwarks
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This window will appear:

B Click the Support tab.

B Click Close.

Wireless Network Connection 7 Status |E||Z|
General| Suppart |
Internet Pratocal [TCPARP]
Addrezz Type: Azzigned by DHCP
IP &ddress: 192168.0114
Subhet bask: 255.255.255.0
Drefault Gateway: 192.168.01

Detailz. ..

Cloge
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Assigning a Static IP Address in Windows® XP/2000

Note: DHCP-enabled routers will automatically assign IP addresses to the computers
on the network, using DHCP (Dynamic Host Configuration Protocol) technology. If you
are using a DHCP-capable router you will not need to assign static IP addresses.

If you are not using a DHCP capable router, or you need to assign a static IP address,
please follow these instructions:

B Go to Start.

B Double-click on Control Panel.

- E.—' Contral Panel
I@ Tour Windows =P

'::j; Prinkers and Faxes
. Files and Settings Transfer
T Wizard

9} Help and Support
w Paink .
p Search

All Programs P E Rum...

| Turn 2

B Double-click on Network Connections.

B Control Panel

File Edit “iew Favorites Tools Help

tJ Back \J 'l_w f) Search u Folders v

Address [} Control Panel

P& Accessibiliy Options
£ add Hardware

u" Control Panel A

L) add or Remave Programs
[} Switch to Categary View | Administrative Tools

See Also

=4
4 Vindows Update ‘Z Game Controllers
@) Help and Suppart B Irternet Options

b= Mebwork Connections
g,Phone and Modem Cptions

3 Power Options
~saPrinters and Faxes
Q Feegional and Language Options
=4, Scannets and Cameras
) acheduled Tasks
) Sounds and Audio Devices

b Taskhar and Skark Menu
3 User Accounts

‘s start
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B Right-click on Local Area Connections.

B Double-click on Properties.

"% Network Connections

File Edit Wiew Favorites Tools  Adwanced Help

eBack - J l’: f/\ search 1‘_ Folders v

Address t_; Metwork Connections

A Mame

Network Tasks LAN or High-Speed Internet

l;g Create a new W— —
connection Disable

% Set up a home or small Status
office network Repair

@& Disable this network -
device: Bridge Connections

Q Repair this connection N

Create Shortcut
Em Renamne this connection Binlabs
) View status of this Rename
connection T
Change settings of this
connection

Properties

Other Places

[ control Panel i
S My Metwark Places

() My Documents

g My Computer

Details

j Wiew o change settings For this connection, such as adapter, protocal, or modem configur]

V5 start

® Click on Internet Protocol (TCP/IP).

m Click Properties.

B Input your IP address and subnet mask. (The IP addresses on your network
must be within the same range. For example, if one computer has an IP address
of 192.168.0.2, the other computers should have IP addresses that are sequential,
like 192.168.0.3 and 192.168.0.4. The subnet mask must be the same for all the
computers on the network.)

- Local Area Connection 7 Properties |E||g|

General | Advanced

Connect uzing:

‘ B8 D-Link DWL-AB50

This connection uzes the following items:

. gclient far Microzaft Netwarks
Q File and Printer Sharing for Microzoft Networks
451 o5 Packet Scheduler

Tranzmigzion Contral Pratocal/lnternet Protocal. The default
wide area netwark protocal that pravides comrunication
acrogs diverse interconnected networks.

[] Show izon in natification area when connected

[TCPAP)
Install... Uninstall
Drescription

0K ] [ Cancel
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B Input your DNS server addresses. (Note: If you are entering a DNS server, you
must enter the IP address of the default gateway.)

The DNS server information will be supplied by your ISP (Internet Service Provider.)

m Click OK.

Internet Protocol (TCP/IP) Properties

General |

“f'ou can get |P settings assigned automatically if your network. supports
this capability. Otherwize, pou need to ask pour network, administrator for
the appropriate |P settings.

(73 Obtain an IP address automatically
(%) Use the following IP address:

IP address: 192 . 168 . 0 . B2

Subnet mask: 255255 255 . 0

Default gateveay: |_1é-2 sElblls O =)
Obtain DS server addiess autornatically

(%) Use the following DNS server addresses:

Prefered DNS server: | 192 168 . 0 . 1

Alternate DNS server: l:l

Assigning a Static IP Address in Macintosh® 0SX

B Go to the Apple Menu and select System Preferences.

B Click on Network.

808C System Preferences

w =A@ 3

Show All © Displays Sound Network Startup Disk

Personal

m M F g e & @

Desktop Dock General International Login Screen Saver Universal
Access

Hardware

¢ = () m 8 34

ColorSync Displays Energy Saver Keyboard Mouse

Internet & Network

® @ Q ¢

Internet Netwaork QuickTime Sharing

System

Q@ & ® § .

Classic Date & Time Software Speech Startup Disk Users
Update
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B Select Built-in Ethernet in the Show pull-down menu.

B Select Manually in the Configure pull-down menu.

e 6 Network (=
i« = NS
Show All Diiﬂ\l'}; Sound Network Startup Disk
Location: = Automatic ?‘
Show: | Built-in Ethernet m
" )
oxies

Manually using DHCP Router
Configure  Using DHCP
Using BootP
= = — N wame Servers (Optional)

IP Address:
(Provided by DHCP Server)

Subnet Mask: 255.255.255.0

Router: 192.168.0.1 Search Domains (Optional)

DHCP Client ID:
(Optional)

Example: apple.com, earthlink.net
Ethernet Address:

(&) Click the lock 10 prevent further changes.

B Input the Static IP Address, the Subnet Mask and the Router IP Address in the
appropriate fields.

m Click Apply Now.

% 80 Network (=
« =8 O
Show All Displays Sound Metwork Startup Disk
Location: = Automatic ﬂ
Show: = Built-in Ethernet ﬂ

frerne ) pero | AppleTalk | Proxies |

Configure: = Manually T‘

Domain Name Servars (Optional)

IP Addrass:  192.168.0.2

Subnet Mask: 255.255.255.0

Router: 102.168 01 Search Domains (Optional)

Example: apple com, earthlink.net
Ethernet Address: 00:09:93:75:de:5a

Apply Now

? Click the lock to prevent further changes.
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B Go to the Apple Menu and select System Preferences.

B Click on Network.

80 System Preferences

w = 4@ 3
—_— v
Show All Displays Sound Newwork Startup Disk

Personal

o . F @ Y @

Deasktop Dack General International Screen Saver Universal
Access

Hardware

= == = =

ColorSync Displays Energy Saver Keyboard

Internet & Network

® @ Q@ =

Internet Network QuickTime Sharing

System

o
R & @ § @ 1L
B - 18 - =
Classic Date & Time Software Speech Starup Disk Users
Update

B Select Built-in Ethernet in the Show pull-down menu.

B Select Using DHCP in the Configure pull-down menu.

‘@6 Network (=)
« =A@ I
Show All © Displays Sound Network Startup Disk
Location: |~ Automatic ﬁ
Show: | Built-in Ethernet Ti

v v —
| Manually PP

Manually using DHCP Router
Configure

Using BootP

;ame Servers (Optional)

IP Address:
(Provided by DHCF Server)

Subnet Mask: 255.255.255.0

Router: 192.168.0.1 Search Domains (Optional)

DHCP Client ID:
(Optional)

Example: apple.com, earthlink.net
Ethernet Addrass:

@ Click the lock to prevent further changes. Apply Now
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m Click Apply Now.

B The IP Address, Subnet mask, and the Router’s IP Address will appear in a few

seconds.
e 0 Network =
« =D 2
Show All Displays Sound Network Startup Disk

=

Location: | Automatic
Show: | Built-in Ethernet PN

TCP/IP | PPPoE | AppleTalk | Proxies

Configure: = Using DHCP 3

Domain Name Servers (Optionall

IP Address: 192.168.0.160
(Provided by DHCP Server)

Subnet Mask: 255.255.255.0

Router: 192.168.0.1 Search Domains (Dptional)

DHCP Client ID; |
(Optional)

Example: apple.com, earthlink.net
Ethernet Address: 00:06:96:79:de:5a

= e
o Click the lock to prevent further changes. Apply Now

Checking the Wireless Connection by Pinging
in Windows® XP and 2000

Go to Start > Run > type ecmd. A window similar to this one will appear. Type ping
XXX.XXX.XXX.XXX, Where xxx is the IP address of the wireless router or access point.
A good wireless connection will show four replies from the wireless router or access
point, as shown.

¢+ F:\WINDOWS\System32\cmd.exe - EEE

Microsoft Windows &F LUersion 5.1.2680] a
Gy Copyright 1985-2001 Microsoft Covp.

F:«Documents and Settingsslab4iping 192.168.8.58
Pinging 192.168.0.580 with 32 bytes of data:
y From 192.168.8.58: byt time=5ms TIL=38

y from 192.168_.8_.58: byt i 3
vy from i ITI

Fing statistics for 172.168.8.58: ] e ] ]
P 32 Sent = 4, Received = 4, Lost = 8 <Bx loss>,

fipproxinate round twip times in milli-seconds
Minimum = 3ms,. Maximum = 64mz,. Average = 2

F:“Documents and SettingsslahdX_
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DWL-3200AP Managed Wireless Access Point. We cover various
aspects of the network setup, including the network adapters. Please read the following
if you are having problems.

Note: It is recommended that you use an Ethernet connection to configure the
DWL-3200AP .

1. The computer used to configure the DWL-3200AP cannot access the
Configuration menu.

B Check that the Ethernet LED on the DWL-3200AP is ON. If the LED is not ON,
check that the cable for the Ethernet connection is securely inserted.

B Check that the Ethernet Adapter is working properly. Please see item 3 (Check
that the drivers for the network adapters are installed properly) in this
Troubleshooting section to check that the drivers are loaded properly.

B Check that the IP address is in the same range and subnet as the DWL-3200AP.
Please see Checking the IP Address in Windows® XP in the Networking Basics
section of this manual.

Note: The IP address of the DWL-3200AP is 192.168.0.50. All the computers on the
network must have a unique IP address in the same range, e.g., 192.168.0.x. Any
computers that have identical IP addresses will not be visible on the network. They
must all have the same subnet mask, e.g., 255.255.255.0.

B Do a Ping test to make sure that the DWL-3200AP is responding. Go to
fStart>ngm>Type Command>Type ping 192.168.0.50. A successful ping will show
our replies.

Note: If you have changed the default IP address, make sure to ping the correct IP
address assigned to the DWL-3200AP.

cv F:\WINDOWS\System32\cmd.exe !EH

Microsoft Windows XP [Uersion 5.1.260081
(C> Copyright 1985-2001 Microsoft Corp.

F:\Documents and Settings\labh3>ping 192.168.0.50

Pinging 192.168.0.50 with 32 hytes of data:

Reply from 192.168.0.58: hytes=32 time<ims TTL=64
Reply from 192.168.08.50: hytes=32 time<ims TTL=64
Reply from 192.168.0.58: bytes=32 time<ims TTL=64
Reply from 192.168.8.58: bhytes=32 time<{ims TTL=64

Ping statistics for 192.168.0.50:

Packets: Sent = 4, Received = 4, Lost = B (Bx loss).
Approximate round trip times in milli-seconds:

Minimum = Bms, Maximum = Oms,. Average = Bns

F:\Documents and Settings\lah3>_
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2.The wireless client cannot access the Internet in the Infrastructure mode.

Make sure the wireless client is associated and joined with the correct access point. To
check this connection: Right-click on the Local Area Connection icon in the taskbar>
select View Available Wireless Networks. The Connect to Wireless Network screen
will appear. Please make sure you have selected the correct available network, as
shown in the illustrations below.

Disable
Status
Repair

View Available Wireless Networks

Open Network Connections

Connect to Wireless Network @@

The ftollowing network(s) are available. To access a network, select
it from the list, and then click Connect.

Available networks:

1 alan T
i dan
x default

i nn

If you are having difficulty connecting to a network, click Advanced.

[ Connect ][ Cancel ]

B Check that the IP address assigned to the wireless adapter is within the same
IP address range as the access point and gateway. Since the DWL-3200AP has
an IP address of 192.168.0.50, wireless adapters must have an IP address in the
same range, e.g., 192.168.0.x. Each device must have a unique IP address; no two
devices may have the same IP address. The subnet mask must be the same for all
the computers on the network.) To check the IP address assigned to the wireless
adapter, double-click on the Local Area Connection icon in the taskbar > select
the Support tab and the IP address will be displayed. Please refer to Checking
the IP Address in the Networking Basics section of this manual.)

B |[fitis necessary to assign a Static IP Address to the wireless adapter, please refer
to the appropriate section in Networking Basics. If you are entering a DNS Server
address you must also enter the Default Gateway Address. (Remember that if
you have a DHCP-capable router, you will not need to assign a static IP address.
See Networking Basics: Assigning a Static IP Address.)
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3. Check that the drivers for the network adapters are installed properly.

You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are

using.
B Go to Start > My Computer > Properties.

@ Windows Media Player W I
Open

Explore
G? Control P Search...
Manage
e_ Connect
= Map Netwark Drive, ..

ﬂ Printers ¢ Disconnect Nekwork Drive. ..

v Show on Desktop

Q_)) Helpand  Rename
) conch Properties

All Programs D

ﬁl Log Off 'G) ‘ Turn OFf Computer

/g start

B Select the Hardware Tab.

® Click Device Manager.

System Properties

Swystem Rastoe | sAudemsse Updstes | Remcte
Genetal | ComputeriMems || Hadwate || Advanced
Al Hardvears Wead

% The Add Hardware vi2ard heips vou inatall hatdwane

[ Add Hardware Wizand ]

Dewce Manage:

The Desace Manager kts ol the hardvaare devices instaled
on wor conputer, Use tha Deizs Mansgat ta change the
prepethas ol eny dence

[ Onegigung | [ DeweeMersper |

Harchvars Profies

o Hardwate prolles prowvids 5 wap fee you to tel up ard sioes
) diferern hadiare corligaaions,

[ Hadwsapriee |

[ ok ][ csneat |
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B Double-click on Network Adapters.

B Right-click on D-Link AirPlus DWL-G650 Wireless Cardbus Adapter. (In this
example we use the DWL-G650; you may be using other network adapters, but the
procedure will remain the same.)

B Select Properties to check that the drivers are installed properly.

5 Device Ma nager Q@Ej

Ele Action View Help
& 2 8 xR

= E,l}- PMTEST
¥ H Batteries

% '¢ Computer
+| e Disk drives
¥ j Display adapters
+ (=) Floppy disk controllers
+- M Floppy disk drives
= (=) IDE ATAJATAPI controllers
+ <2 Keyboards

") Mice and other pointing devices
?, Modems

2 Monitors
H3) Network adapters

£

+ [@ PCMCIA adapters
+- % Ports (COM&LPT)
= %8 Processors
%9, Sound, video and game controllers

+ System devices
- Universal Serial Bus controllers

i}-#-#H-#

B ook under Device Status to check that the device is working properly.
m Click OK.

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

General | Advanced | Settings | Driver | Resources

Eﬁ] D-Link &irPlus DWL-G650 Wireless Cardbus Adapter

Device type: MNetwork adapters
Manufacturer D-Link
Location: PCl bus B, device 0, function 0

Device status
This device is working properly.

If you are having problems with this device, click Troubleshoot to
start the tioubleshooter.

Troubleshoot. .

Device usage.

Use this device [enable) v

[ oK ][ Cancel ]
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4.

What variables may cause my wireless products to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this
manual for further information about the most advantageous placement of your D-Link
wireless products.

5.

6.

Why does my wireless connection keep dropping?

Antenna Orientation- Try different antenna orientations for the DWL-3200AP. Try to
keep the antenna at least 6 inches away from the wall or other objects.

If you are using 2.4GHz cordless phones, X-10 equipment or other home security
systems, ceiling fans, and lights, your wireless connection will degrade dramatically
or drop altogether. Try changing the channel on your router, access point and wireless
adapter to a different channel to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate RF
noise, like microwaves, monitors, electric motors, etc.

Why can’t | get a wireless connection?

If you have enabled encryption on the DWL-3200AP, you must also enable encryption
on all wireless clients in order to establish a wireless connection.

Make sure that the SSID on the router and the wireless client are exactly the same.
If they are not, wireless connection will not be established.

Move the DWL-3200AP and the wireless client into the same room and then test
the wireless connection.

Disable all security settings.

Turn off your DWL-3200AP and the client. Turn the DWL-3200AP back on again,
and then turn on the client.

Make sure that all devices are set to Infrastructure mode.

Check that the LED indicators are indicating normal activity. If not, check that the
AC power and Ethernet cables are firmly connected.

Check that the IP address, subnet mask, gateway and DNS settings are correctly
entered for the network.

If you are using 2.4GHz cordless phones, X-10 equipment or other home security
systems, ceiling fans, and lights, your wireless connection will degrade dramatically
or drop altogether. Try changing the channel on your DWL-3200AP, and on all the
devices in your network to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate RF
noise, like microwaves, monitors, electric motors, etc.
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7. |1 forgot my encryption key.

B Reset the DWL-3200AP to its factory default settings and restore the other devices
on your network to their default settings. You may do this by pressing the Reset
button on the back of the unit. You will lose the current configuration settings.
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Technical Specifications

Standards

¢ |EEE 802.11b
* |[EEE 802.11g
¢ |EEE 802.3

¢ |EEE 802.3u
¢ |EEE 802.3x

Network Management
* Web Browser interface
HTTP
Secure HTTP (HTTPS)
* AP Manager
* SNMP Support
D-View Module
Private MIB
e Command Line Interface
Telnet
Secure SSH Telnet

Data Rates*

For 802.11¢:

* 54, 48, 36, 24, 18, 12, 9 and 6Mbps
For 802.11b:

* 11, 5.5, 2, and1Mbps

Security

* WPA-Personal

* WPA-Enterprise

* WPA2-Personal

* WPA2-Enterprise

* 64/128/152-bit WEP

* SSID Broadcast Disable

* MAC Address Access Control List

Wireless Frequency Range
* 2.4GHz to 2.4835GHz

Wireless Operating Range**

802.11g (Full Power with 5dBi gain diversity dipole antenna)
Indoors:

* 98ft (30m) @ 54Mbps

* 112ft (34m) @ 48Mbps
* 128ft (39m) @ 36Mbps
* 154ft (47m) @ 24Mbps
* 184ft (56m) @ 18Mbps
* 217ft (66m) @ 12Mbps
e 259ft (79m) @ 9Mbps
* 325ft (99m) @ 6Mbps

Py

* Maximum wireless signal rate derived from |IEEE Standard 802.11g specifications. Actual data throughput will vary. Network
conditions and environmental factors, including volume of network traffic, building materials and construction, and network
overhead, lower actual data throughput rate. Environmental factors may adversely affect wireless signal range.

** Environmental conditions may adversely affect wireless signal range.
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Outdoors:

* 367ft (112m) @ 54Mbps
¢ 820ft (250m) @ 18Mbps
¢ 1640ft (500m) @ 6Mbps

Operating Voltage
* 48VDC +/- 10% for PoE

Radio and Modulation Type
For 802.11b:

DSSS:

e DBPSK @ 1Mbps

* DQPSK @ 2Mbps

* CCK @ 5.5 and 11Mbps
For 802.11g:

OFDM:

* BPSK @ 6 and 9Mbps

* QPSK @ 12 and 18Mbps
* 16QAM @ 24 and 36Mbps
* 64QAM @ 48 and 54Mbps
DSSS:

e DBPSK @ 1Mbps

* DQPSK @ 2Mbps

* CCK @ 5.5 and 11Mbps

Transmit Output Power
For 802.11b:

* 100mW (20dBm)

* 50mW (17dBm)

* 30mW (15dBm)

* 20mW (13dBm)

* 10mW (10dBm)

* 5mW (7dBm)

* 1mW (0dBm)

For 802.11g:

* 100mW (20dBm)
* 63mW (18dBm)
* 30mW (15dBm)
* 20mW (13dBm)
* 10mW (10dBm)
* 5mW (7dBm)

* 1mW (0dBm)

EIRP (Effective Isotropic Radiated Power) / Total Output Power (Output Power with 5dBi Antenna)
For 802.11b:

* 400mW (26dBm)

* 160mW (22dBm)

* 100mW (20dBm)

* 63mW (18dBm)

* 32mW (15dBm)

* 16mW (12dBm)

* 3mW (5dBm)
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For 802.11g:

* 400mW (26dBm)
* 200mW (23dBm)
* 100mW (20dBm)
* 63mW (18dBm)
* 32mW (15dBm)
* 16mW (12dBm)
* 3mW (5dBm)

Receiver Sensitivity
For 802.11b:

* 1Mbps: -94dBm

* 2Mbps: -90dBm

* 5.5Mbps: -89dBm
* 11Mbps: -85dBm
For 802.11g:

* 1Mbps: -94dBm

* 2Mbps: -90dBm

* 5.5Mbps: -89dBm
* 6Mbps: -90dBm

* 9Mbps: -84dBm

* 11Mbps: -85dBm
* 12Mbps: -82dBm
* 18Mbps: -80dBm
* 24Mbps: -77dBm
e 36Mbps: -73dBm
* 48Mbps: -72dBm
* 54Mbps: -72dBm

LEDs

e Power

e LAN

* 802.11b/g

Temperature
* Operating: -40°F to 140°F (-40°C to 60°C)
» Storing: -40°F to 149°F (-40°C to 65°C)

Humidity
* Operating: 10%~90% (non-condensing)
* Storing: 5%~95% (non-condensing)

Certifications
*FCC
o WiFi

Dimensions

° L =10.93 inches (277.7mm)
*W =6.10 inches (155mm)
*H=1.77 inches (45mm)

Warranty
* 1 Year
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Contacting Technical Support

Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link Technical Support through our
website, or by phone.

Tech Support for customers within the United States:
D-Link Technical Support over the Telephone:
(877) 453-5465
Monday to Friday 8:00am to 5:00pm PST

D-Link Technical Support over the Internet:
http://support.dlink.com
e-mail:support@dlink.com

Tech Support for customers within Canada:
D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 7:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
e-mail:support@dlink.ca
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Warranty

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
Warranty:

. Only to the person or entity that originally purchased the product from D-Link or its authorized reseller or
distributor, and

e  Only for products purchased and delivered within the fifty states of the United States, the District of Columbia,
U.S. Possessions or Protectorates, U.S. Military Installations, or addresses with an APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link product described below (“Hardware”)
will be free from material defects in workmanship and materials under normal use from the date of original retail
purchase of the product, for the period set forth below (“Warranty Period”), except as otherwise stated herein.

e  Hardware (excluding power supplies and fans): One (1) year
e  Power supplies and fans: One (1) year
e  Spare parts and spare kits: Ninety (90) days

The customer's sole and exclusive remedy and the entire liability of D-Link and its suppliers under this Limited
Warranty will be, at D-Link’s option, to repair or replace the defective Hardware during the Warranty Period at
no charge to the original owner or to refund the actual purchase price paid. Any repair or replacement will be
rendered by D-Link at an Authorized D-Link Service Office. The replacement hardware need not be new or have
an identical make, model or part. D-Link may, at its option, replace the defective Hardware or any part thereof with
any reconditioned product that D-Link reasonably determines is substantially equivalent (or superior) in all material
respects to the defective Hardware. Repaired or replacement hardware will be warranted for the remainder of
the original Warranty Period or ninety (90) days, whichever is longer, and is subject to the same limitations and
exclusions. If a material defect is incapable of correction, or if D-Link determines that it is not practical to repair or
replace the defective Hardware, the actual price paid by the original purchaser for the defective Hardware will be
refunded by D-Link upon return to D-Link of the defective Hardware. All Hardware or part thereof that is replaced
byf D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon replacement or
refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”) will substantially
conform to D-Link’s then current functional specifications for the Software, as set forth in the applicable
documentation, from the date of original retail purchase of the Software for a period of ninety (90) days (“Software
Warranty Period”), provided that the Software is properly installed on approved hardware and operated as
contemplated in its documentation. D-Link further warrants that, during the Software Warranty Period, the magnetic
media on which D-Link delivers the Software will be free of physical defects. The customer’s sole and exclusive
remedy and the entire liability of D-Link and its suppliers under this Limited Warranty will be, at D-Link’s option,
to replace the non-conforming Software (or defective media) with software that substantially conforms to D-Link’s
functional specifications for the Software or to refund the portion of the actual purchase price paid that is attributable
to the Software. Except as otherwise agreed by D-Link in writing, the replacement Software is provided only to
the original licensee, and is subject to the terms and conditions of the license granted by D-Link for the Software.
Replacement Software will be warranted for the remainder of the original Warranty Period and is subject to the
same limitations and exclusions. If a material non-conformance is incapable of correction, or if D-Link determines
in its sole discretion that it is not practical to replace the non-conforming Software, the price paid by the original
licensee for the non-conforming Software will be refunded by D-Link; provided that the non-conforming Software
(and all copies thereof) is first returned to D-Link. The license granted respecting any Software for which a refund
is given automatically terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for Hardware and Software portions
of D-Link’s products will not be applied to and does not cover any refurbished product and any product purchased
through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the liquidators
expressly disclaim their warranty obligation pertaining to the product and in that case, the product is being sold
“As-Is” without any warranty whatsoever including, without limitation, the Limited Warranty as described herein,
notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its return
policy. In case the return policy period has expired and the product is within warranty, the customer shall submit
a claim to D-Link as outlined below:

e The customer must submit with the product as part of the claim a written description of the Hardware defect
or Software nonconformance in sufficient detail to allow D-Link to confirm the same, along with proof of
purchase of the product (such as a copy of the dated purchase invoice for the product) if the product is not
registered.

e  The customer must obtain a Case ID Number from D-Link Technical Support at 1-877-453-5465, who will
attempt to assist the customer in resolving any suspected defects W|th the product If the productis considered
defective, the customer must obtain a Return Materigl A “RMA”) number by completing the RMA
form and entering the assigned Case ID Number at https://rma.dlink.com].

e  Afteran RMAnumber is issued, the defective product must be packaged securely in the original or other suitable
shipping package to ensure that it will not be damaged in transit, and the RMA number must be prominently
marked on the outside of the package. Do not include any manuals or accessories in the shipping package.
D-Link will only replace the defective portion of the product and will not ship back any accessories.

e  The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery (“COD”) is
allowed. Products sent COD will either be rejected by D-Link or become the property of D-Link. Products
shall be fully insured by the customer and shipped to D-Link Systems, Inc., 17595 Mt. Herrmann, Fountain
Valley, CA 92708. D-Link will not be held responsible for any packages that are lost in transit to D-Link.
The repaired or replaced packages will be shipped to the customer via UPS Ground or any common carrier
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selected by D-Link. Return shipping charges shall be prepaid by D-Link if you use an address in the United
States, otherwise we will ship the product to you freight collect. Expedited shipping is available upon request
and provided shipping charges are prepaid by the customer.

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing
requirements, or for which an RMA number is not visible from the outside of the package. The product owner
agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is not packaged
and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective or
non-conforming.

What Is Not Covered: The Limited Warranty provided herein by D-Link does not cover: Products that, in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse, faulty
installation, lack of reasonable care, repair or service in any way that is not contemplated in the documentation
for the product, or if the model or serial number has been altered, tampered with, defaced or removed; Initial
installation, installation and removal of the product for repair, and shipping costs; Operational adjustments covered
in the operating manual for the product, and normal maintenance; Damage that occurs in shipment, due to act of
God, failures due to power surge, and cosmetic damage; Any hardware, software, firmware or other products or
services provided by anyone other than D-Link; and Products that have been purchased from inventory clearance
or liquidation sales or other sales in which D-Link, the sellers, or the liquidators expressly disclaim their warranty
obligation pertaining to the product. While necessary maintenance or repairs on your Product can be performed
by any company, we recommend that you use only an Authorized D-Link Service Office. Improper or incorrectly
performed maintenance or repair voids this Limited Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE PRODUCT
IS PROVIDED “AS-I1S” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING, WITHOUT
LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY TERRITORY WHERE A
PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO THE DURATION
OF THE APPLICABLE WARRANTY PERIOD SET FORTH ABOVE. EXCEPT AS EXPRESSLY COVERED UNDER
THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND
PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER ANY
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FORANY LOSS OF
USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER DIRECT, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF GOODWILL,
LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, FAILURE OF
OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’'S PRODUCT IS CONNECTED WITH,
LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT
RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING FROM THE USE OF THE PRODUCT, RELATING
TO WARRANTY SERVICE, ORARISING OUT OF ANY BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THE SOLE REMEDY FOR A BREACH OF
THE FOREGOING LIMITED WARRANTY IS REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR
NON-CONFORMING PRODUCT. THE MAXIMUM LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED
TO THE PURCHASE PRICE OF THE PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS
WRITTEN WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES
OR REMEDIES, EXPRESS, IMPLIED OR STATUTORY.

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some states do not
allow exclusion or limitation of incidental or consequential damages, or limitations on how long an implied warranty
lasts, so the foregoing limitations and exclusions may not apply. This Limited Warranty provides specific legal rights
and you may also have other rights which vary from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered trademarks
are the property of their respective owners.

Copyright Statement: No part of this publication or documentation accompanying this product may be reproduced
in any form or by any means or used to make any derivative such as translation, transformation, or adaptation
without permission from D-Link Corporation/D-Link Systems, Inc., as stipulated by the United States Copyright Act
of 1976 and any amendments thereto. Contents are subject to change without prior notice. Copyright 2005 by
D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio interference,
in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio
communication. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following

measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.

. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
. Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty information applicable to products purchased outside the United
States, please contact the corresponding local D-Link office.
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DWL-3200AP User’s Manual Registration

Registration

»—f’*‘fRegister your product online at:
http://support.dlink.com/register

Product registration is entirely voluntary and failure to complete or return
this form will not diminish your warranty rights.

Version 1.04
March 22, 2006
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